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1 Overview

1.1 Introduction

Capture QMix-UC

Universal ControlStudio One Artist UC Surface

The StudioLive™ 16.0.2 USB mixer comes with a powerful software library 
that includes Capture™ and Studio One® Artist. In addition, PreSonus UC 
Surface editor/librarian/remote-control software for macOS® and Windows® 
is a free download from the PreSonus. PreSonus also offers UC Surface 
software for iPad® and Windows Touch devices as well as QMix™ UC aux-mix 
control software for iOS and Android devices; both are free downloads.

Whether you want to remote-control your StudioLive from a tablet, provide 
your musicians with the ability to control their own monitor mixes from their 
mobile devices, record a live show with just one mouse click, mix your next 
hit album, or any combination of the above, your StudioLive mixer and its 
companion software applications provide you with a complete suite of tools.

We encourage you to contact us with questions or comments regarding 
this product. PreSonus Audio Electronics is committed to constant 
product improvement, and we value your suggestions highly. We believe 
the best way to achieve our goal of constant product improvement is by 
listening to the real experts: our valued customers. We appreciate the 
support you have shown us through the purchase of this product.
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1.2 About This Manual

We suggest that you use this manual to familiarize yourself with the features 
and correct connection procedures for your StudioLive 16.0.2 USB Software 
Library before trying to connect your StudioLive to your computer, iPad, or 
mobile device. This will help you avoid problems during installation and setup.

Throughout this manual you will find Power User Tips. These tips provide 
useful hints on how to best use the StudioLive 16.0.2 USB Software Library 
and take advantage of unique workflow functions and features.

1.3 Technical Support

Many technical issues can arise when using a standard computer as a 
digital audio workstation (DAW) and when networking wireless devices. 
PreSonus can only provide support for issues that directly relate to the 
StudioLive mixer, UC Surface, QMix-UC, Capture, and Studio One.

PreSonus does not provide support for computer hardware, iOS 
hardware, Android devices, wireless networks, operating systems, and 
non-PreSonus hardware and software, and it may be necessary to 
contact the manufacturer of these products for technical support.

Please check our Web site (www.presonus.com) regularly for 
software information and updates, firmware updates, and 
support documentation for frequently asked questions.

Online technical support is available at http://support.presonus.
com, as well as from your http://my.presonus.com account.

Advanced troubleshooting guides can be found at support.presonus.com/forums.

1.4 Summary StudioLive Software Library Features

1.4.1 UC Surface

With battle-ready PreSonus® UC Surface multi-touch control software, 
every control you need to mix a show is under your fingertips exactly 
when you need it. UC Surface maintains the same workflow with Windows, 
Mac, and iPad for control of the StudioLive™ 16.0.2 USB mixer.

 • Battle-ready interface designed for mixing live sound

 • Complete control of every StudioLive Series III, AI-
series, and 16.0.2 USB mixer on the network

 • Multiplatform and Network Support

 • Touch-ready interface

 • Windows 8 multi-touch compatible for large touchscreen mixing

 • Complete overview of all input and outputs

 • Meter Bridge scroll bar 

 • Mix Select buttons with activity meters

 • Master faders accessible at all times

 • Contextual-based navigation for quick, intuitive access to all 
mixing functions: Fat Channel, graphic EQ, effects, channels

 • Flex Fader control over selected mix

 • Quickly audition presets on the fly and edit them before loading 

 • Complete control of Fat Channel processing 

http://www.presonus.com
http://support.presonus.com
http://support.presonus.com
http://my.presonus.com
http://support.presonus.com/forums
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1.4.2 QMix™ UC for iPhone®, iPod touch®, and Android devices

QMix-UC provides performers with wireless control over their monitor (aux) 
mixes onstage and in the recording studio from their mobile devices.

 • Provides wireless control over StudioLive 16.0.2 USB mixers 
connected to UC Surface for macOS or Windows.

 • Remote-control aux mixes on any StudioLive on the same network.

 • Using the Wheel of Me, control the levels of all of the user’s 
channels simultaneously, with one simple control.

 • Create four channel groups to easily manage large monitor mixes.

 • Set permissions on your StudioLive mixer so that  
QMix-UC only controls a specified aux mix.

 • Available free from the Apple App Store and Google Play.

1.4.3 Capture 

Included with every StudioLive mixer is Capture, a digital-audio 
multitrack-recording application designed to make recording quick and 
easy. Perfect for live recording and for mixing your audio in real time 
to a stereo audio file, Capture was designed to interface perfectly with 
StudioLive-series mixers, allowing instant setup and recording.

Capture allows you to record every input channel on your StudioLive 
mixer plus a single stereo mix with the click of a single button.

 • Multitrack recording application: record every input channel 
plus the Main mix from your StudioLive mixer

 • One-click recording with Record Now button

 • Prerecord captures audio up to a minute before you press Record

 • Auto-Save at user-definable intervals

 • Automatic session and file recovery if the power fails

 • Sessions store metadata, enabling automatic session naming

 • Soundcheck mode makes it simple to virtually 
soundcheck using previously recorded material

 • Session Lock feature prevents accidental keyboard access

 • Essential editing suite (copy, cut, paste, splice, resize)

 • Big Meter mode turns your monitor into a gigantic meter bridge

 • Stereo Playback mode—use Capture with any computer sound card

 • Peak LED-style meter bridge with clip indicators

 • Marker placement and recall

 • Marker List with Quick Locate

 • Export between markers

 • Full transport control

 • Import/export individual WAV, AIFF, or OpenTL

 • Compatible with macOS® and Windows®
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1.4.4 Studio One Artist

All PreSonus audio interfaces include PreSonus Studio One Artist recording 
software, which comes with over 6 GB of plug-ins, loops, and samples, giving 
you everything you need for music recording and production. The Studio 
One Artist Quick Start Guide is located in Section 8 of this manual. You will 
find a complete user manual inside the Studio One Artist Help menu.

 • Unlimited track count, inserts, sends, and plug-in instantiations

 • 20 high-quality PreSonus Native Effects™ plug-ins, in eight categories: 
amp modeling (Ampire XT), delay (Analog Delay, Beat Delay), distortion 
(RedLight Dist™), dynamics processing (Channel Strip, Compressor, Gate, 
Expander, Limiter, Tricomp™), equalizer (Channel Strip, Pro EQ), modulation 
(Autofilter, Chorus, Flange, Phaser, X-Trem), reverb (Mixverb™, Room Reverb), 
and utility (Binaural Pan, Mixtool, Phase Meter, Spectrum Meter, Tuner)

 • Four high-quality PreSonus virtual instruments, including: 
Presence™ sample player, Impact™ drum machine, SampleOne™ 
sampler, and Mojito analog-modeled subtractive synthesizer

 • Over 6 GB of loops, samples, and instruments

 • Open Capture files natively

 • Innovative and intuitive MIDI mapping

 • Powerful drag-and-drop functionality for faster workflow

 • macOS® and Windows® compatible

 • Customize your Studio One Artist installation with Studio One Add-ons

 • Discounted upgrade to Studio One Pro right from within Studio One Artist
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2 Connecting to a Computer

The Universal Control installer includes the ASIO/WDM (Windows) and Core Audio 
(macOS) drivers for StudioLive mixers, as well as the UC Surface application. We made 
this installer as simple and easy to follow as possible, and it will take you through 
each step of the installation process. Please read each message carefully to ensure 
Universal Control, the StudioLive driver and UC Surface are properly installed. In 
particular, be careful not to connect your StudioLive to the computer too soon.

Please visit www.presonus.com for the latest system requirements 
and an updated list of compatible hardware. It is also recommend 
that you check your recording software’s system requirements.

Power User Tip: As part of our commitment to the quality of our products, PreSonus 
continually updates its product drivers and software. The latest version of your entire 
StudioLive 16.0.2 USB Software Library can be downloaded directly from your My 
PreSonus account as soon as you register your StudioLive mixer. My PreSonus is also your 
portal to support, the PreSonus Shop, and more. 

The speed of your processor, amount of RAM, and capacity, size, and speed of your hard 
drives will greatly affect the overall performance of your recording system. A faster 
processor and more RAM can reduce signal latency (delay) and improve overall 
performance.

2.1 Installation for Windows

Before beginning the Universal Control installation setup, please quit all applications, 
including antivirus software, and disconnect the StudioLive from your computer.

Follow the onscreen instructions to complete the installation. When the 
installer has finished, it will prompt you to reboot your computer. 
 
 
 
 
 
 

Click “Finish” to automatically restart your PC. Once your computer has 
rebooted, connect the StudioLive. When the Found New Hardware wizard 
launches, follow the “Recommended” steps. 
 
 
 
 
 

Your StudioLive is now synced to your computer and ready to use!
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2.2 Installation for macOS

The UC Surface installer will take you through each step of the 
installation process. Please read each message carefully, and be especially 
careful that you do not connect your StudioLive too soon.

1. After launching the installer, you will be directed to the Welcome screen. 
Click “Continue” and follow the onscreen instructions. 
 
 
 
 
 

2. You will be asked which installation type you would like to perform. You do 
not need to install the StudioLive AI-series FireWire Driver.  
 
 
 
 
 

3. When the installation is completed, you will be prompted to reboot your 
computer. After your Mac has restarted, connect your StudioLive with the 
appropriate transport cable and power it on. 
 
 
 
 

4. Once the installation is completed, you will find the UC Surface program in 
your Applications folder. It is recommended that you place this in your Dock.

You are now ready to use your StudioLive with your computer!

2.3 Using the StudioLive as an Audio Interface

The StudioLive mixers feature a built-in audio interface that can be 
used with any application that supports Core Audio or ASIO and 
can also be used as a WDM device for a Windows computer.

Every input plus the Main mix can be recorded. Please review Section 2.5 of this 
manual for more information on using audio streams are for recording and playback. 

Power User Tip: If your StudioLive will not connect to the computer, verify that the  
USB cable is properly connected to the StudioLive and to your computer and disconnect 
all unnecessary peripheral devices on the same transport bus.
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2.4 Using the StudioLive with Popular Audio Applications

Below are basic driver-setup instructions for several popular audio applications. 
Complete setup instructions for PreSonus Studio One Artist and a brief 
tutorial on its features are located in Section 8 of this manual. If your audio 
application is not listed in this section, please consult your application’s user 
documentation for information on selecting an audio device driver.

Steinberg Cubase 4+

1. Launch Cubase.

2. Go to Devices | Device Setup.

3. Select “VST Audio System” from the Devices column in the Device Setup.

4. Select StudioLive 16.0.2 USB from the ASIO Driver dropdown list.

5. Click “Switch” to begin using the StudioLive Driver.

6. Once you have successfully changed the driver, go to Devices | 
VST Connections to enable your input and output buses.

Ableton Live 5+

1. Launch Ableton Live.

2. Go to Options | Preferences | Audio.

3. Choose Driver Type: ASIO | Audio Device: StudioLive 16.0.2 USB

4. Go to Input Config : Enable and select the desired Input channels.

5. Go to Output Config : Enable and select the desired Output channels.

6. You may now select the StudioLive’s inputs and 
outputs for each track created in Live.

Apple Logic Pro/Express 7+:

1. Launch Logic Pro/Express.

2. Go to Logic | Preferences | Audio.

3. Click on the Devices Tab.

4. On the Core Audio tab, check Enabled.

5. Select StudioLive 16.0.2 USB from the device menu.

6. You will be asked if you’d like to relaunch Logic. Click “try (re)launch.”

7. Your StudioLive features custom I/O labels for faster work flow. To enable 
these labels for use in Logic, go to Options | Audio | I/O Labels.

8. The second column in the pop-up window will be named 
“Provided by Driver.” Activate each of these labels for your 
StudioLive. When you are done, close this window.

9. You are now ready to use your StudioLive.
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Avid Pro Tools 9+

1. Launch Pro Tools.

2. Got to Setup | Hardware and select StudioLive 16.0.2 
USB from the Peripherals list. Click OK.

3. Go to Setup | Playback Engine and select StudioLive 16.0.2 
USB from the menu at the top of the window. Click OK.

Cakewalk Sonar 6+

1. Launch Sonar.

2. Go to Options | Audio... and click on the Advanced tab.

3. Change the Driver Mode to “ASIO.”

4. Click the “OK” button.

5. Restart Sonar.

6. Go to Options | Audio... and click on the Drivers tab.

7. Highlight all input and output drivers beginning with “16.0.2 USB.”

8. Go to Options | Audio... and click on the General tab.

9. Set the Playback Timing Master to “StudioLive 16.0.2 USB ... Channel 1”,

10. Set the Recording Timing Master to “StudioLive 16.0.2 USB ... Channel 1”

2.5 Digital Sends and Returns

When using the StudioLive as an audio interface, it is important to understand 
the terms “digital send” and “digital return.” Because the audio interface 
in the StudioLive is completely integrated with the other functions of the 
mixer, the USB I/O is designed to work as an independent bus. You can 
route (send) signals from other buses to the digital transport bus, and its 
output (return) signal is hard-coded to designated mixer channels.

The StudioLive 16.0.2 USB 18 available sends and 16 returns.

2.5.1 Channel Digital Sends

Every Digital Send is hard-coded to be sent pre-fader from the input channels of the 
StudioLive. These sends can be pre- or post-Fat Channel EQ and dynamics.

To record the EQ and dynamics processing on any channel, simply enable the 
Post button in the Digital Out section. It will illuminate, indicating that the 
Fat Channel signal path is being routed to the Digital Send. If this mode is not 
enabled, the signal sent will be post-trim and post-analog insert (if applicable).

There also is an additional pair of Digital Sends dedicated to record the 
Main bus. These sends are always post-Fat Channel and post-fader.



9

2 Connecting to a Computer 
2.6 Using Plug-In Effects as Inserts

StudioLive™ Software  
Library Reference Manual

2.5.2 Digital Returns

Each StudioLive input is hard-coded to receive its respective digital return. The DAW 
Outputs in your recording application route these playback streams to their 
respective channels on the StudioLive (that is, the software’s Output 1 always goes to 
StudioLive Channel 1 digital return and so on). Once you route a track in your 
recording application to play through one of these outputs, it will always be 
accessible on its channel by simply pressing the Digital Return button.

Power User Tip: It is important to think of your digital returns and your analog inputs in 
the same way. When a digital return is engaged, it replaces the analog input in the mix. 
You can process it in the Fat Channel, include in it Aux mixes, and send it to an FX mix. It is 
also important to note that the analog input is still available to be recorded, or processed 
with a plug-in, in your DAW host application even if the digital return is engaged.

2.5.3 Main Digital Return

To provide the most flexible mixing environment, PreSonus has provided a 
stereo Main Digital Return to free the channels returns to be patched directly 
to their corresponding channels on your StudioLive mixer. In this way, you 
can monitor the main output from your recording application without using 
two channels on your StudioLive, leaving the other channels available to be 
routed to the Fat Channel or for inserting a plug-in on a live instrument.

 • These digital returns are selectable as the tape 
return source in the monitor section.

 • StudioLive 16.0.2 USB Returns 1 and 2 are always routed to both the 
Main Digital Return and the Digital Returns on Channels 1 and 2.

2.6 Using Plug-In Effects as Inserts

Digital Transport streaming on your StudioLive is continuously bidirectional. This 
means that the StudioLive is always sending signals from the analog inputs to 
the direct Digital Sends on all input channels. At the same time, the StudioLive is 
receiving signals back from the digital returns. Because the digital returns always 
come back to their respective StudioLive channels, you can quickly insert a plug-in 
from your recording application into any channel strip and monitor it in real time.

In this example, we will insert the Beat Delay plug-in from 
PreSonus Studio One onto Channel 4 of the StudioLive.

1. To begin, create a mono audio track in Studio One. 
 
 
 
 
 
 
 
 

2. Assign its input to Channel 4 and its output to Output 4.

(Several DAW applications, including Apple Logic, do not offer mono 
output buses. If this is the case, you must route the output stream to, for 
example, Channels 3-4 and pan the channel all the way to the right so 
that it will only be sent to Output 4. Please consult your software’s user 
manual for specific instructions.) 
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3. Once you have the routing set up in Studio One, drag-and-drop the Beat 
Delay plug-in onto your track and record-enable it. Software monitoring 
will be enabled automatically. 
 
 
 
 
 
 
 
 

4. To enable the Digital Return on Channel 4 of your StudioLive, first press 
the USB multimode button.  
 
 
 
 
 
 
 

5. Press the multimode button on Channel 4. You can now monitor the 
analog signal from Channel 4 on your StudioLive with your inserted 
effect (in this case, Beat Delay).

Power User Tip: When using plug-ins as inserts, it is very important that you set 
as low a buffer size on your computer as possible without creating performance 
issues. For most new computers, this won’t be an issue. A buffer size of 128 or less 
will provide low enough latency for most plug-in types; however, dynamics and 
EQ plug-ins and performance plug-ins such as amp-modelers may require lower 
latency settings. See Section 4.1 for more information on buffer size settings.

Please note: setting the buffer size too low on older or slower computers, or on a 
computer that has not been properly optimized, may result in poor 
performance. Always be sure to test the limits of your system before attempting 
CPU-intensive tasks in mission-critical situations.
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3 Networking Your Remote Devices

In order to use your mobile devices to remote control your StudioLive 16.0.2 
USB mixer, you must first connect it to a Mac or Windows computer via 
USB with Universal Control installed and running. The computer running 
Universal Control must then be connected to the same network as your 
mobile devices. This section will cover networking proceedures.

Power User Tip: Network connections occasionally require troubleshooting, especially 
when a lot of wireless networks are in use. Because of this, it is always a good idea to get 
your networked devices and StudioLive happily communicating before the pressure is on, 
and you have a singer trying to dial in a monitor mix while you’re trying to mic the drum 
kit. So while the guitarist is flirting with the bartender, take a quick moment to get your 
iPad, iPhone, computer, and StudioLive talking.

3.1 Connecting your Computer to your Network

Windows 7+

1. Click on the network icon in the notification area to 
open the Connect to Network Control Panel.

2. Select the wireless network you’d like to use.

3. Enter the password.

4. Click Connect.

macOS 10.8 and later

1. On the Menu bar click on the Wireless Status icon.

2. From the pull-down menu select the wireless network you’d like to use.

3. Enter the password.

4. Click Join.

Router

Laptop running
UC Surface

Android phone
running QMix-UC

iPad running
UC Surface
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3.2 Connecting your iPad to your Network

1. Tap on the Settings icon in your iPad.

2. Tap on “Wi-Fi.”

3. Under “Choose a Network,” find the same network to which your 
computer is connected. Tap the network to select it.

4. Enter the password when prompted and tap Join.

5. Tap on the menu arrow to the right of the desired 
network’s name to open its network settings.

6. Turn Auto-Join to “On.” You are now ready to launch UC Surface. 

3.3 Connecting your iPhone/iPod touch to your Network

1. Tap on the Settings icon in your iPhone/iPod touch.

2. Tap on “Wi-Fi” making sure it is set to “On.”

3. Under “Choose a Network,” select the same network 
to which your computer is connected.

4. Tap on the network to select it.

5. Enter the password when prompted and tap Join.

Important: You must connect your computer and iOS devices to the same network each 
time you plan on remote-controlling your StudioLive with UC Surface, or QMix-UC. 
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4 Universal Control

Universal Control is a powerful hardware management application for all PreSonus® 
interface products. It allows you to manage any PreSonus interface product 
connected to your computer or your computer’s network.  
 
 

4.1 Universal Control Launch Window

When Universal Control is launched, you will see the Launch Window. From 
this window, you can manage all the Core Audio and ASIO driver settings.

Sample Rate. Changes the sample rate.

You can set the sample rate to 44.1 or 48 kHz. A higher sample rate will 
increase the fidelity of the recording but will increase the file size and 
the amount of system resources necessary to process the audio. 

Block Size. Sets the buffer size. 

From this menu, you can set the buffer size from 32 to 4,096 samples (macOS®), or 64 
to 8,192 samples (Windows®). Lowering the buffer size will lower latency; however, 
this will also increase performance demands on your computer. In general, you will 
want to set the buffer size as low as your system can safely support. If you begin 
to hear pops, clicks, or distortion in your audio path, try raising the buffer size. 

File Menu. Manages devices connected to Universal Control.

 • Show All Devices. Launches all control windows for all supported devices 
connected to your computer’s network or host transport (USB or FireWire).

 • Close All Devices. Closes all open control windows.

 • About Universal Control. Displays version and build date information.

 • Quit. Quits the Universal Control application and all hardware control windows.
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Settings Menu. Provide customization options to 
personalize your Universal Control experience.

 • Always on Top. Keeps the Universal Control Launch window on 
top whether it is the currently active application or not.

 • Run at Startup. Launches Universal Control 
automatically when your computer boots.

 • Preferences. Sets language and appearance options (see below).

 • Rescan Network. Scans the network and local transport bus 
(USB or FireWire) for all supported PreSonus products.

 • Language. Sets the language (English, French, German, Korean, Simplified 
Chinese, or Spanish). 

Demo. Allows you to launch a virtual connection to a StudioLive 
32.4.2AI, StudioLive RM32AI or StudioLive 32 mixer.

Preferences. Sets language and appearance options.

 • General. Sets the language preference for Universal Control and UC Surface.

 • Appearance. Allows you to adjust the overall brightness of UC 
Surface. Choose between Default, Light, and Bright.

Default Light Bright

 • Touch Input. Provides options to connect TUIO devices on 
macOS. See Section 4.2 for example setup instructions.
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4.2 TUIO Setup (macOS)

TUIO allows multi-touch displays to connect to macOS. If you would like to use a 
multi-touch display with your Apple computer, check the box next to “Enable TUIO.” 

Once enabled, you must set the UDP port to match the value set by your multi-
touch display’s driver. By default, the UDP port is set to 3333. This is the most 
common value and it is unlikely that you will need to change this value.

If you are using a multi-touch display with one or more displays, you must identify 
which one will be sending multi-touch control to Universal Control. To set this, simply 
drag the Universal Control Preferences dialog to your multi-touch display and click 
or tap the “This” button. This will set the monitor value to the correct number.
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5 UC Surface Mix Control Software

UC Surface is a powerful software application that provides control of channel, 
subgroup, aux, and bus levels; Fat Channel parameters; aux mixes; effects; 
and graphic EQs. It also provides a visual overview of your StudioLive settings 
so that you can see, adjust, and organize them. UC Surface also includes 
a librarian, allowing you to easily manage your presets and scenes. 

UC Surface provides bidirectional control that allows you to remote-control 
mixing functions that are also available from their respective hardware control 
surfaces. Since control is bidirectional, fader moves and parameter changes made 
on the StudioLive mixing surface are reflected in UC Surface and vice versa. 

UC Surface will run on macOS, Windows, Windows Touch, or iPad® 
devices, affording flexible control options for any mix situation.

To use UC Surface, you must do the following:

1. Install UC Surface on your computer.

2. Connect your StudioLive 16.0.2 USB to an available USB port.

3. Connect your computer to your preferred wireless network.

4. Launch UC Surface on your computer.

5. Connect your mobile devices to your preferred wireless network.

6. Start mixing!!

5.1 UC Surface Mix Controls

Mix Select

The Mix Select buttons allow you to choose the mix you’d like to control 
(Aux 1-4, FX A/B, Mains). In addition, UC Surface provides a mix for 
each of the effects buses. The returns for these effects are available 
in each mix to customize the amount of reverb and delay.
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The Mix Selection button for every mix is visible only when the Mixes tab is active.

Copy Mix

Copying the current mix allows you to quickly set up multiple mixes. 

1. To copy a mix to any other mix, press the Copy Mix button. 
 

2. Click on the desired destination mix(es). 
 
 
 
 
 
 
 

3. Click Paste to paste the mix or click Cancel to stop the operation. 
 

Flex Fader

The fader immediately to the left of the Mix Select buttons controls the output level 
of the currently selected mix.  
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Main Fader

The fader(s) to the right of the Mix Select buttons always control(s) the Main  
mix level. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.1.1 Channel Controls

1. Fat Channel Select. Opens the Fat Channel controls for the channel/mix. This 
microview displays an overview of the EQ curve you set in the Fat Channel. See 
Section 5.2 for more information about the Fat Channel section and its functions.

2. Solo Button. Turns soloing on and off.

3. Mute Button. Turns muting on and off.

4. Pan Controls. The Pan control sets the channel’s relative position in the 
left/right stereo mix. When a pair of channels is stereo linked, the Pan 
control sets the spread of the channels in the left/right stereo mix.

5. Channel Fader. Controls the Overall Level of the 
Channel. Unity gain (0 dB) is denoted by a “U.”

6. Level Meter. Displays the prefader level of each channel. 
 
 
 

1

2
3
4

5

6
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5.2 Fat Channel Controls

Every input and bus on your StudioLive mixer is equipped with Fat Channel 
dynamics processing and filtering. The revolutionary Fat Channel is the heart of 
the StudioLive. The Fat Channel makes dynamics, routing, and panning for every 
input and output on the StudioLive available at the touch of a Select button. 

The Fat Channel’s processing section consists of five parts: High-Pass Filter, 
Noise Gate, Compressor, Limiter, and parametric EQ. Each can be turned on 
or off and controlled separately. This processing is global across all mixes. 

The signal flows as follows: 

5.2.1 Input Controls

When an input channel is selected, the following controls 
will be available at the far left of the Fat Channel:

1

4

2

3

5

1. Preamp Controls. For all input channels, phantom power and 
polarity control are available from the Fat Channel. 

2. High-Pass Filter Controls. Sets the High-Pass Filter Frequency Threshold and 
engages / disengages the High-Pass Filter for currently selected channel.

3. USB Return. Engages / disengages the USB return 
for the currently selected channel.

4. Post. Sets the USB send position pre- or post-Fat 
Channel for the currently selected channel.

5. Link. Engages / disengages stereo linking for the currently selected channel.

Hi-Pass LimiterEQØ Noise Gate Compressor
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5.2.2 Mix Detail

When a mix is selected, the following controls will be 
available at the far left of the Fat Channel:

1

2

1. High-Pass Filter Controls. Sets the High-Pass Filter Frequency Threshold and 
engages / disengages the High-Pass Filter for currently selected channel.

2. Link Mix. Links the selected mix to the one adjacent to create a stereo bus.

5.2.3 Noise Gate

To view the controls for the Noise Gate, click on the Gate tab.

1. Gate On/Off. Turns the Gate On and Off for the selected channel.

2. Gate Threshold. Sets the level at which the gate opens. Essentially, all 
signals above the threshold setting are passed through unaffected, whereas 
signals below the threshold setting are reduced in level by the amount 
set by the range control. You can set the threshold from 0 to -56 dB.

3. Gate Graph. This graph shows the point at which the gate 
threshold affects the signal. You can either use this graph to adjust 
the threshold or the dedicated threshold control (#2).

1

2

3
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5.2.4 Compressor

To view the controls for the Compressor, click on the Compressor tab.

1. Compressor On/Off. Turns the Compressor On and Off for the selected channel.

2. Compressor Graph. This graph shows the point at which the 
compressor threshold affects the signal. You can use this graph to 
adjust the threshold or use the dedicated Threshold control (#3).

3. Compressor Response. Sets the compressor response for the 
selected channel or output bus. The Response control sets the 
attack and release tapers for the Compressor simultaneously.

4. Compressor Threshold. Sets the compressor threshold for the selected channel 
or output bus. When the signal’s amplitude (level) exceeds the threshold 
setting, the compressor engages. The threshold can be set from -56 to 0 dB.

5. Auto Mode Button. When Auto mode is active, the Attack and Release 
controls become inoperative, and a preprogrammed attack and release 
curve is used. In this mode, the attack is set to 10 ms, and the release is set to 
150 ms. All other compressor parameters can still be adjusted manually.

6. Ratio. Sets the compression ratio (or slope) for the selected channel or output 
bus. The ratio sets the compression slope, which is a function of the output 
level versus the input level. For example, if you have the ratio set to 2:1, any 
signal levels above the threshold setting will be compressed at a ratio of 
2:1. This means that for every 2 dB of level increase above the threshold, the 
compressor’s output will only increase 1 dB. The ratio can be set from 1:1 to 14:.

7. Compressor Makeup Gain. Sets the amount of makeup gain for the selected 
channel or output bus. When compressing a signal, gain reduction usually results 
in an overall attenuation of level. The gain control allows you to restore this 
loss in level and readjust the volume to the pre-compression level (if desired). 
You can adjust Makeup Gain from 0 dB (no gain adjustment) to +28 dB.

1
2

4
5

6

7

3
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5.2.5 Equalizer

To view the controls for the parametric EQ, click on the Equalizer tab.

1. EQ Frequency. Adjusts the center frequency of each band. 

2. EQ Gain. Sets level of the center frequency from -15 to +15 dB.

3. EQ Graph. This graph shows overall EQ curve.

4. High Shelf EQ On/Off. Enabling the High Shelf button turns the High band 
into a shelving EQ. A high shelving EQ is like a treble-control knob on a stereo. 
In this mode, the Center Frequency control selects the shelving frequency.

5. Low Shelf EQ On/Off. Enabling the Low Shelf button turns the Low band 
into a shelving EQ. A low shelving EQ is like a bass-control knob on a stereo. 
In this mode, the Center Frequency control selects the shelving frequency.

6. EQ Band Select. Opens the controls for the selected EQ band.

5.2.6 Limiter

To turn the limiter on or off, click on the power button on the Limiter tab. 
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5.3 Graphic EQ 

To the left of the Fat Channel, you will find the GEQ button. This opens up the graphic 
EQ for the Main bus.

In general, graphic EQ settings are created prior to a live show and 
are not adjusted after that. However, minor adjustments sometimes 
must be made later. UC Surface makes this quick and easy.

1. GEQ On/Off. By default, all graphic EQs are disabled. To 
enable any GEQ, simply click on this button. 

2. Draw GEQ. Enabling the Draw function will allow you to draw a GEQ curve 
with your finger or mouse rather than adjusting each band individually.

3. Reset GEQ. To zero out all curve settings on any graphic EQ, click on 
the Reset GEQ button. This will return all band gains to 0 dB.

5.4 Adding Effects

Your StudioLive mixer is equipped with two internal effects 
processors each with a dedicated mix bus. The effects returns 
for both effects buses can be routed to any mix.

Creating an effects mix is just like creating a monitor mix: Simply 
click on the effects mix and select and set the level for each 
channel to which you would like to apply reverb or delay. 

5.4.1 Editing Effects

To access the effects library for each processor and make adjustments to effects 
parameters, click on the FX View button on the left side of the Fat Channel. Across 
the top of the window, you see each of the effects buses and the current selected 
effects type for both buses. To edit any effect, simply click on its bus.

This will open the effects editor. From here, you can change 
the effects type, adjust parameters, and load presets.

1 2 3
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5.5 Scenes and Presets

The presets button in UC Surface is a contextual function that follows the currently 
selected mode: Fat Channel presets, GEQ presets, FX presets, or Mix Scene. 

5.5.1 Fat Channel Presets

While the Fat Channel is active, this button launches the Fat Channel presets menu. 
To close the menu and reopen the mixer view, simply click the button again.

1. Current Channel. The Channel controls for the currently selected 
channel are available at the left of the Preset Manager.

2. Previous Channel. Selects the previous channel.

3. Channel Selection. Displays the currently selected channel. The preset 
manager will automatically load and store presets to and from this 
channel. Click on this menu to select a new channel to manage.

4. Next Channel. Selects the next channel.

5. Copy/Paste. To copy the Fat Channel settings to another channel, 
simply click on Copy, select the channel you’d like to load the 
settings to from the Channel Select menu, and click Paste.

6. Preset Manager. Displays presets that are stored locally on 
the device running UC Surface and presets stored locally on 
the mixer. See Section 5.5.5 for more information.

7. Recall. Loads the current preset to the selected channel.

8. Save. Creates a Fat Channel preset from the currently selected channel’s settings.

1

7

8
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5.5.2 GEQ Presets

While the GEQ View button is active, the Preset button launches the GEQ Presets 
menu. To close the menu and reopen the mixer view, simply click the button again. 
 

1. Recall. Loads the current preset to the selected bus. 

2. Store. Creates a GEQ preset from the currently selected bus GEQ’s settings. 

3. Preset Manager. Displays presets that are stored locally on 
the device running UC Surface and presets stored locally on 
the mixer. See Section 5.5.5 for more information. 

4. Copy/Paste. To copy the effects settings to another bus’s GEQ, 
simply click on Copy; from the GEQ Bus Select menu, select the 
bus to which you’d like to load the settings; and click Paste. 

5.5.3 FX Presets

While the FX View button is active, the Preset button launches the FX Presets menu. 
To close the menu and reopen the mixer view, simply click the button again. 
 

1. Recall. Loads the current preset to the selected channel.

2. Store. Creates an effects preset from the currently selected effects bus settings.

1

4

2 3

1

4
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3. Preset Manager. Displays presets that are stored locally on 
the device running UC Surface and presets stored locally on 
the mixer. See Section 5.5.5 for more information.

4. Copy/Paste. To copy the effects settings to another effects bus, simply 
click on Copy; from the banner at the top of the window, select the 
bus to which you’d like to load the settings; and click Paste.

5.5.4 Scenes

While the Scenes button is active, the Preset button launches the Scene library menu. 
To close the menu and reopen the mixer view, simply click the button again. 
 

1. Recall. Loads the current preset to the selected channel.

2. Store. Creates an effects preset from the currently selected effects bus settings.

3. Recall Filters. The Recall Filters allow you to select 
what part of the Mix Scene to omit or recall.

4. Preset Manager. Displays presets that are stored locally on 
the device running UC Surface and presets stored locally on 
the mixer. See Section 5.5.5 for more information.

5.5.5 Preset and Scene Management

Presets and scenes can be stored locally on your StudioLive mixer 
or locally on your computer and copied between the two.

Syncing the Mixer Library

Presets and Scenes stored in the mixer library can be copied to the device 
running UC Surface either individually or you can sync the entire preset library.

1 2 3 4
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To sync every preset or scene, click or touch the Sync all button.

You can copy individual presets and scenes to and from your mixer’s memory 
by simply dragging dropping them between the Mixer and Local sections of 
the Library Management area. You can also select presets individually and 
use the arrow buttons to transfer them to and from your mixer’s memory.

5.6 Quick Panel Functions

The Quick Panel provides easy access to the following functions: 
Talkback, Talkback Assign, FX Bus mutes, and Tap Tempo.

To open or close the Quick Panel, click on the arrow in the lower right hand corner of 
the screen. 

5.6.1 Talkback

The Talkback feature lets you communicate with the performers.

Click on the Talkback button to enable the Talk function on your StudioLive mixer. 

To select the destination for your Talkback routing, 
click or tap the mix group to select it. 

The Select buttons for the mixes that have Talkback routed to 
them will turn red to indicate that Talkback is active.

5.6.2 Fader Locate

The  StudioLive 16.0.2 USB is not equipped with motorized faders. 
So when you remote control your mixer from UC Surface, the main 
mix you see in UC Surface and hear in your front-of-house speakers 
will not match the mix you see on the physical faders.

The Fader Locate button provides a visual representation of where your physical 
faders are, relative to the virtual faders in UC Surface. Moving a fader on your 
StudioLive 16.0.2 USB mixer will not affect the mix until it intersects with the current 
position of the virtual fader.

5.6.3 FX Mutes

These buttons mute their respective effects buses. 
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5.7 The Settings Page

The Settings page allows you to customize your StudioLive mixer 
and UC Surface, allowing you to create a flexible mix system 
for your application. From the settings page you can:

 • Customize the look and feel of UC Surface

 • Set Device Permissions

 • Configure MIDI Control

 • Restore you mixer to default settings

 • Set the source for your Monitor Bus

To open the Configuration Settings page, click on the Settings button in the upper 
right hand corner of UC Surface.

5.7.1. Device Settings Tab 

The Device Settings tab allows you to customize your StudioLive 
experience in UC Surface and manage your remote mobile devices.

5.7.1.1 Device Permissions

Controlling your StudioLive remotely with UC Surface or QMix-UC for 
mobile devices allows you to move about the venue freely. However, it can 
also put the full power of the StudioLive in multiple hands— some more 
adept than others. Therefore, your StudioLive enables you to limit each 
wireless device’s access to the mixer features by setting permissions. 

Once a device is connected to StudioLive 16.0.2 USB either via USB or over the same 
network to which your computer is connected and has launched UC Surface or 
QMix-UC, the device will be displayed in the Device Permissions list. Each device will 
be listed using its device name so you can easily identify which device is which. 

Once you have connected and configured a device, the same 
permissions will be set for that device every time you connect it. 
Complete information about QMix-UC can be found in Section 6.



29

5 UC Surface Mix Control Software 
5.7 The Settings Page

StudioLive™ Software  
Library Reference Manual

When setting permissions for UC Surface users, you will choose between 
giving full access to all mix functions or providing limited access to just a 
few aux-mix functions. In most cases, one iPad will be configured as front-
of-house (FOH), and the others will be configured as aux mixes. 

UC Surface Mix Permissions. Sets the level of functionality in UC Surface. 

 • None. The selected device will not be able to control your StudioLive mixer.

 • FOH. Enables all UC Surface functions for the selected device. 

 • All Auxes. The selected device will only control the 
channel send levels for all aux mixes. 

 • Aux 1... UC Surface will only control the channel 
send levels for the specified aux mix. 

 • Other Permissions. Choose between Ch Rename or None. Ch Rename allows 
UC Surface users to remotely change the channel and bus scribble-strip labels.

 • Change Access Code. This button allows you to set a custom access 
code for each UC Surface device so that once permissions have 
been set, they cannot be changed locally on the device without 
the correct access code. By default, the access code is 12345.

When setting permissions for QMix-UC users, you will choose between 
providing full access to all aux mixes, providing access to only a single 
aux mix, and limiting the user to just the Wheel of Me functions. 

QMix-UC Permissions. Sets the level of functionality in QMix-UC. 

 • None. The selected device will not be able to control your StudioLive mixer. 

 • All Auxes. QMix-UC will control the channel send levels for all aux mixes. 

 • Aux 1... QMix-UC will only control the channel 
send levels for the specified aux mix. 

 • Other Permissions. Choose between Wheel Only or None. Wheel Only disables 
the Aux Mix page in QMix-UC. When this is enabled, the user will only be able 
to use the Wheel of Me on the single aux to which you’ve provided access. 
When Wheel Only is enabled, you can only give access to one aux mix. 

5.7.1.2 Configure Lockout

You can lock out the functions of your StudioLive 16.0.2 USB 
when you are away from it by creating a password. 

1. To do this, you must click on the Configure Lockout button from the Settings 
page.
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2. Enter the 5-digit numeric passcode you would like to use.

3. To make the mixer able to be locked, enable Device is Lockable.

4. Click Set Lockout save the passcode.

Locking Your Mixer

Once the passcode has been set, you can lock or unlock your mixer any 
time by navigating to Page 5 of the System menu on your mixer.

Press the Select buttons that correspond to the 5-digit code you 
saved. For example, if you set the passcode as 1-2-3-4-5, you would 
press the Select buttons for Channels 1-5 respectively.
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5.7.1.3 Firmware

UC Surface allows you to view the currently installed firmware version on your 
StudioLive mixer as well as the version of UC Surface you are running. This is 
the same information that’s displayed on the last page of the System menu.

5.7.1.4 System Settings 

The System Settings area allows you to customize your StudioLive mixer. 

2

3

4

5

6

1

1. Solo PFL. Engages / disengages Pre-Fader Listen soloing.

2. Sync Select. Syncs channel selection between the mixer 
and across all devices running UC Surface.

3. Color Scheme. Luminosity presets and slider control to 
compensate for environmental light interference. 

4. Show Edit Popup. Presents a large display of parameter value for each function.

5. Restore Factory Presets. Restores all Factory Presets to their original parameters.

6. Monitor Assign. Sets the source for the Monitor bus.
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5.7.2 MIDI Control Tab

The StudioLive 16.0.2 USB can be remotely controlled with a DAW, a 
MIDI footswitch, a MIDI keyboard, and an assortment of other MIDI 
control devices. The MIDI Control Tab allows you turn MIDI Control 
Mode on as well as select on which MIDI channels the StudioLive will be 
controlled, and which MIDI Control Change messages will be used.

For more information on controlling your StudioLive 16.0.2 
USB from Studio One, please see Section 8.5.

For more information on controlling your StudioLive 16.0.2 USB from an external 
MIDI controller, please review your StudioLive 16.0.2 USB Hardware Manual.

6
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1. MIDI Control. Turns MIDI Mode on or off. MIDI Mode must be 
enabled to remotely control your StudioLive over USB or MIDI.

2. Scene Recall MIDI Channel. Sets the MIDI channel on which the 
mixer will receive Scene Recall Program Change messages.

3. Levels MIDI Channel. Sets the MIDI channel on which 
the mixer will receive Level and Mute messages.

4. FX A Recall MIDI Channel. Sets the MIDI channel on which the 
mixer will receive FX A Preset Program Change messages.

5. FX B Recall MIDI Channel. Sets the MIDI channel on which the 
mixer will receive FX B Preset Program Change messages.

6. Main Level CC message. Sets the CC message 
used to adjust the Main Output Level.

7. FX A Level CC message. Sets the CC message used to adjust the FX A Level.

8. FX A Mute CC message. Sets the CC message used to adjust the FX A Mute.

9. FX B Level CC message. Sets the CC message used to adjust the FX B Level.

10. FX A Mute CC message. Sets the CC message used to adjust the FX B Mute.
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5.7.3 Backup Tab

From the Backup tab, you can create a snapshot of every preset and setting 
on your StudioLive 16.0.2 USB mixer by clicking on the Backup button.

To Restore your mixer to an earlier state, simply select the 
desired backup file and click the Restore button.
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6 QMix-UC for Mobile Devices

QMix-UC for iOS (iPhone and iPod touch) and Android™ puts each 
musician’s monitor (aux) mix in their own hands. With QMix-UC, you can 
adjust each StudioLive channel’s aux-send level to taste and can create 
up to four groups of channels that you simultaneously control with the 
amazing Wheel of Me. All you need is a wireless router and a mobile iOS or 
Android device, and you’re ready to take control of your own destiny.

Note: Please visit www.presonus.com for a list of supported Android devices.

Mobile iOS and Android devices offer two viewing options: Landscape and Portrait.

These two orientations open different windows. When you hold your mobile device 
in Landscape view, the Aux Mix window will open. When you hold your mobile 
device in Portrait view, the Wheel of Me and Group Masters windows will be visible.

To launch QMix-UC, tap on the QMix-UC icon on your mobile device. When you 
launch QMix-UC, you will be taken to the Start page. 
 

On the Start page, you will see a list of every supported mixer on the network. You 
can also view QMix-UC using Demo Mixer simulations. These offline simulations 
enable you to practice your finger control away from your StudioLive.

To connect to your mixer, tap on the StudioLive device icon to open 
QMix-UC and control the mixer from your mobile device.

Tapping the Reconnect button will automatically scan the network for the last 
StudioLive mixer to which QMix-UC was connected. 
 

http://www.presonus.com
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6.1 Aux Mix Page

The Aux Mix page shows the send level for each channel on each aux to 
which your device has access. It corresponds directly to the aux mixes on your 
StudioLive and has been streamlined to show only the send levels. To open 
the Aux Mix page, simply hold your mobile device in Landscape view:

1 3 4 5 72 6 7 8

1. Home. Returns to the Start page and the available device list.

2. Channel Send Levels. Sets the Channel Send Levels to the 
Selected Aux Bus. To adjust the send levels for any channel, tap 
anywhere in the channel’s level control and move your finger up 
or down while maintaining constant contact with the screen. 

Power User Tip: The aux sends support off-axis movement. Once you have touched 
a send-level control to select it, you can slide your finger anywhere in the screen and 
make an up/down movement to control the send level.

3. Settings. Opens the Settings menu. (See Section 6.3.)

4. Lock Orientation. Enabling the Lock Orientation button will lock 
your mobile device in Landscape view. While this button is enabled, 
you cannot open the Wheel of Me. Locking the view will also remove 
the Start page button. Until this option is disabled, QMix-UC will 
launch in this view when connected to the current mixer.

Power User Tip: If QMix-UC doesn’t change pages when you change your mobile 
device’s orientation, make sure that Lock Orientation is not enabled.

5. Channel Pan. When a stereo mix is selected, you find pan modules above 
each channel to control the channel’s relative pan position in the mix.

6. Aux Mix Select. Displays channel send levels to Aux bus. To 
navigate right or left, touch anywhere in the Aux tabs and swipe 
your finger to the left or right. Swiping left scrolls the screen 
to the left. Swiping right scrolls the screen to the right.

Note: Your device’s access to aux mixes is determined from your StudioLive mixer. If 
you only have access to one aux mix, verify your device’s permissions in UC Surface or 
in the System menu on your mixer. 

7. Channel Meter. Displays the channel’s current signal level. Use 
this meter to determine if a particular channel has signal and 
to see how hot a signal is before you set the send level.

8. Groups. QMix-UC allows you to create four groups of channels for easier mix 
management. This button enables / disables this functionality. See Section 6.1.1.

9. Edit Groups. Tap this button to view the four groups 
and add channels to each. See Section 6.1.1.
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6.1.1 Channel Grouping

Channel grouping is a great way to easily manage your mix. Creating a group will let 
you organize groups of channels and manage the overall volume of the entire group 
without changing the relative level of each channel in the group. For instance, you 
can create a group of all your drum channels so that once you dial in just the right 
drum mix, you can turn your drums up or down with one fader instead of twelve.

1. To create a group (or four), tap on the arrow next to the Groups button. 

2. This will reveal the Group Edit buttons. 

3. Tap on the Group Edit button to add or remove channels. 

4. Tap on the channels you’d like to add to your group. As you select channels, 
their color will change to match the currently selected group’s color.

5. When you done editing groups, tap the arrow again to hide the group editor. 
 

6. Once you have created groups, you will be able to globally 
enable/disable them using the Groups On / Off button.
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To manage your Group masters, flip your mobile device to Portrait mode 
and swipe to the third screen. This will open the Group Masters view and 
allow you to control the overall level of each group in your mix.

To rename a group and give it a customized label, tap on the default name (Group 1, 
Group 2, etc.). This will open the keyboard and allow you to name the group masters.

6.2 Wheel of Me

QMix-UC’s Wheel of Me provides you with an easy and effective way to control 
all of the channels that contain your voice and instruments. To open the Wheel 
of Me, turn your mobile device to the Portrait view. The Wheel of Me will open 
for the currently selected aux mix, so if you have Aux Mix 3 selected on the Aux 
Mix page, Aux Mix 3 will still be selected when you open the Wheel of Me.

To begin, set up your monitor mix using the Aux Mix page in QMix-UC, 
UC Surface, or your StudioLive. Once you have your monitor mix dialed 
in to taste, you simply need to identify which channels are yours. After 
this, the Wheel of Me will control the volume of all your channels as a 
group, preserving the volume of each channel relative to the others.
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To select your “Me” channels, swipe to the left.

From the Me page, you can identify which channels are yours in any aux mix. 
For example, if you sing backup vocals and play bass, you probably want 
to hear more of those channels, so you would identify those channels as 
“Me.” As a bass player, you might also want the kick-drum level to increase in 
proportion to your bass, in which case identify that channel as “Me” as well.

Once you’ve identified these channels as Me channels, the Wheel of Me will 
increase or decrease the level of these channels concurrently, allowing you 
to create a DCA group of your most critical channels in your monitor mix.

To return to the Wheel of Me, swipe to the right.

The Wheel of Me increases or decreases the level of your Me channels as a mix 
relative to the rest of the channels (the Band). If you increase the level of your Me 
channels beyond the top level, rather than further raising the Me level, the Band 
channels will decrease in volume, producing the illusion of “even more me.”

On either side of the Wheel of Me, you will find Me and Band mix indicators. These 
level displays show the balance between the Me channels and the Band channels. 
The Band channels consist of any channels not identified as Me channels. These 
indicators will adjust automatically as you move the Wheel of Me up or down. 

Power User Tip: The Band indicator will not show a level until you create an aux mix on 
the Aux Mix page. The Me indicator won’t show a level until at least one channel is 
selected on the Me Channels page. If all channels in the aux mix are selected on the Me 
Channels page, level will only be shown in the Me indicator, and no level will be shown in 
the Band indicator.

Lock Orientation. Enabling the Lock Orientation button will lock your mobile device 
in Portrait view. While this button is enabled, you cannot open the Aux Mix page. 
Locking the view will also remove the Start Page button. Until this option is disabled, 
QMix-UC will launch in this view connected to the current mixer.

Power User Tip: If QMix-UC doesn’t change pages when you change your mobile device’s 
orientation, make sure that Lock Orientation is not enabled.

6.3 Settings Page

To open the Settings page, tap on the Settings button on the Aux Mix page or Wheel 
of Me page. From the Settings page, you can customize QMix-UC scrolling and create 
custom names for each channel and aux mix.

Scroll by Page. Turning this option off will allow you to scroll 
one channel at a time, offering more granular control.

Peak Hold Metering. When Peak Hold Metering is enabled, each meter 
in QMix-UC will continue to display the most recent signal peak.
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7 Capture

PreSonus® Capture™ is a multitrack digital-audio recording application designed to 
make recording with StudioLive™ mixers quick and easy. With the look and feel of 
a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same high-
quality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its Session 
files can be opened directly in Studio One—no conversion or exporting required.

Capture 2 was designed exclusively for StudioLive-series mixers, 
allowing instant setup and recording directly from the mixer, with 
no configuration. Just launch Capture 2 and click Record Now. At 
the end of the show, click Stop, save the file, and you’re done!

7.1 Installation Instructions

7.1.1 macOS

Installing Capture on macOS machines is as simple as drag-and-drop.

1. Double-click on the Capture .dmg file. 
 
 
 
 
 
 

2. Drag the Capture 2 icon to the Applications folder shortcut. 
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3. Once Capture has been copied to your hard drive, it is ready to use. 
Simply open your Application folder and double-click on the Capture 2 
icon. 
 
 
 
 

7.1.2 Windows

The Windows installer for Capture was designed with easy-to-follow 
onscreen instructions to make the installation process quick and simple.

1. When you launch the Capture.exe file, a Welcome Screen will launch. If you 
haven’t already done so, close all other open applications before clicking “Next.” 
 
 
 
 

2. Before Capture can be installed on your computer, you must first agree to the 
licensing terms. Click “I agree.” 
 
 
 
 

3. By default, Capture will install in the Program Files folder on your computer. It is 
highly recommended that you do not change this default location. Click “Install.” 
 
 
 
 

4. Once Capture has been successfully installed on your computer, you can click 
“Finish” to exit the install wizard. You’re ready to start recording! 
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7.2 Start Page

You will be taken to the Start page when Capture is launched. The Start page allows 
you to create a new Session, open a Session stored on your computer, view recent 
Sessions, and verify that your StudioLive is properly communicating with its driver. In 
addition, you can begin recording instantly by just clicking the Record Now button.

7.2.1 Tagging and Organizing a Session

At the top of the Start page, you will find the three Name 
Scheme fields: Artist, Performance, and Location. By 
entering information into each of these fields, your Session 
will be automatically named with this information, in this 
order, and tagged with the same helpful metadata.

These tags also help to keep your files organized. Rather 
than throwing every Session into a single folder, all tagged 
Sessions will automatically be put into an organized 
folder hierarchy. By default, Capture 2 inserts the date of 
performance and creates subfolders. These options can be 
changed in the Options menu, see Section 7.2.5 for details.

By default, the folder tree is Artist/Performance/Location. 
This structure is useful for regularly gigging bands that want 
to archive performances (e.g., Artist: PreSonus All Stars, 
Performance: Winter Tour 2013, Location: Baton Rouge – 
Manship Theatre). However, Capture 2 doesn’t limit you to this 
folder structure. You can change the folder hierarchy from the 
Options menu. Here are other available Name Schemes:

 • Location/Artist/Performance. This Name Scheme is especially useful 
for venue owners who are archiving the performances on their stage 
(e.g., Location: Manship Theatre/PreSonus All Stars/Winter Tour 2013.

 • Location/Performance/Artist. Use this Name Scheme when recording 
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus All Stars).

As you archive your performances, Capture stores a history of the names you have 
entered into each field. To use a name again, simply click on the pull-down menu for 
that field and select it from the list. 
 
 

To clear the currently selected name from the list, select Remove First from the 
pull-down menu. 
 
 
 

To remove every name in the list, select Clear History. Once the history has been 
cleared, it cannot be undone, so be certain before you choose this option. 
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7.2.2 Creating a Session

Below the Name Scheme fields, you will find the New Session button. Click on the 
New Session button to create an empty Session.

Power User Tip: A Session is a Capture file in which you record, arrange, and edit your 
audio files. Session files should not be confused with audio files. Think of a Capture 
Session as you would a StudioLive scene. It is a snapshot of which audio files were 
recorded and how they were edited.

You can also create a new Session by doing one of the following:

1. Navigate to File/New Session. 
 
 
 
 
 
 
 

2. Press [Ctrl]/[Cmd]+N on the keyboard.

If you have filled in the Name Scheme fields, your 
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

 • Session Title. This will be the title of your Session and will 
be the Session filename, as well as the name of the new 
folder that contains all data related to your Session.

 • Session Folder. This is where new Sessions and all related data will be saved. 
The Session location can be chosen each time you create a Session. By default, 
the new Session location will be the Capture folder in your Documents folder.
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You can choose a different file location by clicking on the Browse button and 
browsing to a new location. The last known save location will appear as the default 
the next time you create a new Session.

Power User Tip: The Name Scheme fields have been added to Capture to help keep your 
Sessions organized and to make your archived library of live performances more easily 
searchable. Because of this, we highly recommend that you always take a moment to fill 
in these fields.

Record Now! Clicking the Record Now button on the Start page will launch a new 
Session, arm all tracks for recording, and begin recording immediately. If you do not 
have any of the Name Scheme fields customized, your Session will be labeled with 
today’s date. 

7.2.3 Open a Session

The Capture Start page provides two different ways 
to quickly open previous Sessions. 

Open Session Button

Clicking on the Open Session button will open a browser that will allow you to 
browse for, and open, an existing Session. 
 

Recent Files List

Located below the Open Session button, you will find the 
Recent Files list. This list includes links to the most recently 
opened documents. Click on any of these links to quickly 
open the Session. 
 
 
 
 

Locate Missing Files

In the event that the Session you open is missing audio files, 
Capture will help you find them. Use Session>Locate Missing 
Files to search your computer for lost resources. 
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7.2.4 Audio Device and Sample Rate

Capture was created for use with PreSonus StudioLive-series mixers and 
fully functions only with that device. The Audio Device menu displays 
the currently selected audio driver. When a StudioLive is connected, 
you should select “PreSonus” from the Audio Device list.

If the currently selected audio device has exactly two outputs (as with the built-
in audio card in a Mac), Capture goes into Stereo mode. While in Stereo mode, 
Capture connects all tracks to the stereo output and adjusts the volume of the 
output automatically to account for stereo summing. Stereo mode enables you 
to listen to Sessions while away from your StudioLive. Unless the StudioLive’s 
driver is selected, you cannot create a new Session or record new audio.

The Sample Rate menu displays the currently configured sample rate. To 
change the sample rate, open Universal Control. (See Section 4 for details.)

7.2.5 Options Menu

The Options button can be found just above the bottom of the Start page. This 
launches the Options menu. 
 
 

This menu can also be accessed from Capture>Options. 
 
 
 
 
 
 
 

It can also be accessed by clicking on the Options button on the Session page.

The Options menu provides all the tools necessary 
to configure your Session preferences.

Audio Options

 • Audio Device. At the top of the Audio Options, you will find 
the Audio Device menu. This is the same menu that is on 
the Start page. See Section 7.2.4 for information.
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 • Device Block Size. This displays the buffer size. In general, the higher the 
buffer size is set, the more stable your recording environment will be.

 • Sample Rate. The Sample Rate menu is also found on the 
Start page. See Section 7.2.4 for information.

 • Record Format. The Record Format menu allows you to 
choose the bit-depth of the recorded audio. You can select 16-
bit WAV, 24-bit WAV, or 32-bit floating-point WAV. 

Power User Tip: The higher the bit-depth of your audio, the better its resolution, and 
the bigger the resulting file size will be. In general, we recommend recording at 
24-bit.

 • Pre-Record. Capture allows you to set a Pre-Record buffer. This buffer 
starts recording audio before your click the Record button so you 
won’t miss the beginning of a performance. The Pre-Record buffer 
time is user-selectable, between five seconds and one minute.

Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture will 
require. For example, a 32-track recording with a Pre-Record buffer of 1 minute will 
require approximately 800 MB more RAM than the same recording set with a buffer 
of 5 seconds. While this will not cause problems on modern systems that are 
equipped with copious amounts of RAM, it is highly recommended that the Pre-
Record buffer be set as low as possible on systems with the minimum amount of 
required RAM (2 GB).

Timeline Sync Options

 • Timeline Sync Mode. Capture features a Timeline Sync mode. This allows 
you to align the timeline in your recording Session to the time of day 
or to sync it to an external MIDI Time Code signal. This will also affect 
the timestamp information, which is written into the audio files.

 • No sync. The timeline will start at 0 and will display the length of 
your recording (in minutes and seconds only). This option is useful 
when you only want to track the length of your recording.

 • Sync to computer time. The timeline ruler will start at the exact time of 
day the recording began. This option is useful when recording multiple 
performances over the course of a day (e.g., at a festival stage).

 • Sync to MTC. Capture will align the timeline to incoming MIDI Time 
Code. This option is useful when recording audio for a live video.

 • MIDI Time Code Input. To use the Sync to MTC option, you 
must provide Capture with an input for the source time 
code. You can select that source from this menu.
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File Handling Options

As discussed in Section 7.2.1, Capture provides an assortment 
of useful tools to organize and label Capture Sessions.

 • Storage Location. By default, all Capture Sessions are stored in the 
Capture subfolder in your Documents folder. You can set a new default 
location by clicking on the “Change…” link. This will launch a browser 
window, allowing you to find a new location for your Capture Sessions.

 • Name Scheme. Section 7.2.1 discusses the various options 
for naming and organizing your files. This option enables you 
to select the order in which your files are categorized.

 • Create Subfolders. Clicking the Create Subfolders options will 
create a folder for each of the three naming conventions: Artist, 
Performance, and Location. If this box is not checked, your Session 
and the resulting audio files will still be labeled using these tags but a 
folder hierarchy will not be created. This box is enabled by default.

 • Add Date to Path. By default, Capture automatically adds the date of the Session 
to the Session name. You can remove the date by unchecking this option.
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7.3 The Session Page

Capture features a single-window user interface so you don’t need to 
manage multiple windows and views. When a new Session is created, or an 
existing Session is opened, you will be taken to the Session page. This page 
contains all of the necessary tools to record and edit multitrack audio.

Capture takes full advantage of the StudioLive’s bidirectional digital transport 
bus and hardwired configuration. When you launch Capture, a recording track 
is created for each input channel on your StudioLive. That track, in turn, is 
automatically patched to the corresponding digital return on your StudioLive 
mixer for playback. The following diagrams show this one-to-one relationship.

Capture 2 Recording Routing

Capture 2 Playback Routing

There is no need to set up audio inputs and outputs in Capture, as the software 
automatically detects which StudioLive model is connected and auto-configures for 
it. Each input from the StudioLive mixer is represented with a mono input track in the 
Track column of the Session and has a corresponding level meter in the meter bridge.
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An additional stereo track will also be added to the 
Session for recording the Main Mix. 

It is possible to process each StudioLive mixer input channel with the Fat 
Channel before the input signal is routed to Capture. To do this, engage 
the Post button in the Fat Channel for each channel in your StudioLive 
mixer. This routes the signal post-EQ and post-dynamics processing.

7.3.1 Track Column

Along the left side of the Session page, you will find the Track column. The Track 
column contains a dedicated audio track for each audio input into Capture from the 
StudioLive mixer, including a stereo track to record and provides the following 
essential functions: 
 
 
 
 
 
 
 

Track Naming.

To name a track, double-click on the default name to open a text-
edit box. Enter the name you would like to use and hit Enter.

There are several benefits to giving each track in your Session a name. First, 
it allows you to know at a glance what is being recording where. Second, if 
you name your tracks before you begin recording, the audio file recorded 
on your named track will be given the same name. So, for example, instead 
of a bass line being recorded as Track 15, it would be recorded as Bass.

Power User Tip: As with UC Surface and Studio One, you can press the Tab key to move to 
the next track’s name field.

Arm All.

In the upper left-hand corner, you will find the Arm All button. Click this button to 
arm (enable) all inputs for recording.

Track Controls.

Each track in the Track column features the same controls.

Record Arm Button. Next to each track number is the Record Arm button. When 
this button is active, Capture is ready to record audio that is routed to the track.

Power User Tip: The track number to the left of each track in the list corresponds directly 
to the same channel number on your StudioLive mixer.

Track Mute. Each track features a Mute button. This mutes the track during playback.

Track Solo. Each track features a Solo button. This will solo the track and mute 
all other tracks during playback (similar to the SIP function on the StudioLive).



49

7 Capture 
7.3 The Session Page

StudioLive™ Software  
Library Reference Manual

7.3.2 Transport

The Transport is located in the top left corner of the 
Session page. It contains all the functions you need to 
navigate through your Session. 
 
 

Stop. Stops playback. 
 

Play. Starts playback at the current playback-cursor position. 
 

Record. Starts recording at the current playback-cursor position. 
 

Session Lock. The Record Lock button prevents the recording from accidentally 
being stopped by an errant press of the space bar. Session Lock is automatically 
enabled when Capture starts recording. It can be defeated by simply clicking on it.

Power User Tip: Markers can still be edited and dropped while Session Lock is enabled. 

Return to Zero. Returns the playback cursor to the beginning of the Session. 

Previous Marker. Jumps the playback cursor to the previous marker. 

Rewind. Rewinds as long as this button is enabled. 

Fast Forward. Fast-forwards as long as this button is enabled. 

Next Marker. Jumps the playback cursor to the next marker. 

Go To End. Jumps the playback cursor to the end of the recorded audio. 

Loop. Engages/disengages Loop mode. See Section 7.3.6.6 for more information. 
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7.3.3 Time Display

The Time Display provides you with critical information about your recording.

Session Name. Displays the name of the current Session.

Record Duration. Displays how long the current Session has been recording.

Cursor Time. Displays the current timeline position of the playback cursor.

Remaining Time. Displays the remaining time that can be recorded, based on the 
size of the available storage left on the hard drive to which you are recording.

7.3.4 Timeline Ruler

At the top of the Session Editor, you will find the Timeline 
Ruler. This displays time increments in seconds.

As mentioned in Section 7.2.5, you can set the Timeline Ruler to sync to 
your computer’s clock or to an external MIDI Time Code source.

7.3.5 Navigating the Session

Zooming

You can zoom in and out of your Session, with respect to time, in the Session 
Edit window, so that you can look at the entire length of the Session or 
just view a small region of time to make accurate edits. You can also zoom 
in and out with respect to the size of the audio files in your Session.

To zoom, do one of the following:

 • To zoom in or out, click-and-drag left or right on the Horizontal Zoom scroll bar 
in the lower right-hand corner of the Edit window.

 • Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press 
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.

 • Click inside the Timeline Ruler at any point in time 
and drag down or up to zoom in or out. 

 • In the lower left-hand corner of the Edit window, you will find the vertical-zoom 
controls. These controls increase or decrease the height of the tracks and audio 
files. 
 
 
 
 

Scrolling

To scroll left and right through time in your Session, click-and-drag 
the horizontal scroll bar near the bottom of the Edit window.

You can also scroll through your Session by clicking and 
dragging the Timeline Ruler left or right.
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Locate Selection

To jump the playback cursor to the beginning of any audio event, 
press L on the keyboard or select Session>Locate Selection.

7.3.6 Editing Tools

In the upper right corner, you will see four editing-tool buttons. These 
tools will determine the function of your mouse during editing.

Power User Tip: The audio-editing process can be unforgiving. Small inaccuracies when 
splitting, moving, or performing other actions on recorded audio can lead to unwanted 
results. As simple as it may seem, the act of listening while editing is often overlooked. For 
instance, when sizing the edges of a vocal part to remove unwanted sounds between 
words, it is tempting to make the edits based on the visual representation of the 
waveform. While this may work sometimes, it is much better to listen as you size the 
events to be sure you are not removing any critical part of the vocals. Listening to your 
edits as you make them will save time and frustration in nearly every case.

7.3.6.1 Arrow Tool

This is the default tool for access to most functions. Click on the Arrow tool button or 
press [number 1] on the keyboard to select the Arrow tool.

The Arrow tool can be used for the following purposes:

Move an Event.

To move an audio event using the Arrow tool, click anywhere on the event and 
drag left, right, up, or down. Dragging the event left or right will move the event 
backward or forward in time. When dragging an event left or right beyond the 
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.



52

7 Capture 
7.3 The Session Page

StudioLive™ Software  
Library Reference Manual

Dragging the event up or down will move the event to another track. 
When dragging an event from one track to another (up or down), the 
position of the event will be constrained within an automatic snapping 
range to make it easy to keep the event at the same time position. To 
defeat this snapping, hold Shift while dragging the event up or down.

Rearrange Tracks.

To rearrange tracks using the Arrow tool, click on the track you want to move 
and drag up or down in the Tracks list. You will notice a blue line following your 
mouse. When you drop the track, it will be inserted where the blue line is located.

Size an Event.

Events can be thought of as windows into audio files and musical performances, 
where what you see is what you hear. You can resize events to make them shorter 
or longer so that only a portion of the audio or musical data is seen and heard.

To size any event using the Arrow tool, float the mouse to the left or right edge of the 
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to 
size the event. Events can be sized and resized nondestructively any number of times.
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Select Multiple Events. 

Multiple events can be selected in order to edit them all at once, with a single 
action. To select multiple events with the Arrow tool, do one of the following:

 • Click outside of the range of an event and then drag over any other 
events; a gray box will be drawn while you drag over the target-selection 
area. Release the mouse button once the box is drawn over all of the 
events you wish to edit, and these events will be selected for editing.

 • Click on any event; then, while holding [Shift] on the keyboard, click on any other 
events to select them. This allows you to select multiple events that are not in 
close proximity to each other. All selected events can then be edited at once.

7.3.6.2 Range Tool

The Range tool is used to select a range, or area, within events. Click on the Range 
tool button or press [number 2] on the keyboard to select the Range tool. 

To select a range within an event, using the Range tool, click-and-drag over the 
area to be selected; a gray box will be drawn over the target selection area. Release 
the mouse button when the box is drawn over the range of the events you wish to 
select. The range you have selected is now treated as a single, consolidated event.

The Range tool can be useful in several ways:

 • You can use the Range tool to select the content of several audio events 
across multiple tracks for a specific portion of a song (say, an amazing 
drum groove) and then use the Arrow tool to move that section of 
audio to another section of a song (say, to replace a drum groove).

 • Another common use of the Range tool is to quickly select and delete a 
range of audio within an event, rather than using the Split tool to make 
two splits, then select and delete the section with the Arrow tool.

Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool 
will temporarily appear. This makes it easy to quickly select and edit a range of events.
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To select multiple, discontiguous ranges across any event, on any track, hold the 
[Shift] key while using the Range tool. Continue to hold [Shift] and use the Arrow 
tool to select whole events. For instance, when using the Arrow tool, if you press 
and hold [Ctrl], you get the Range tool. Press and hold [Ctrl] and [Shift] to select 
multiple ranges, then continue to hold [Shift] but release [Ctrl]; now you have the 
Arrow tool and can select whole events. All of your selections will remain selected.

Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left 
and right edges of the selection by choosing Split Range from the Edit 
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

7.3.6.3 Split Tool

Using the Split tool, single events can be split into multiple events. Click on the Split 
Tool button or press [number 3] on the keyboard to select the Split tool.

With the Split tool selected, a vertical and horizontal line will be drawn near the 
current mouse-cursor position. The vertical line indicates the exact time position 
of the Split tool, while the horizontal line underscores the track on which the event 
to be split resides. The Split tool is directly affected by the current Snap settings.

Click on any event with the Split tool to split the event at that position. 
By splitting a single event, you create two events that can be edited 
independently. If multiple events are selected across multiple tracks, 
the Split tool will affect all of the selected events in the same way.

It is also possible to split selected events at the timeline cursor, without 
using the Split tool, by pressing [Alt]+[X] on the keyboard.

7.3.6.4 Eraser Tool

The Eraser tool is used to delete an event. Click on the Eraser Tool button or press 
[number 4] on the keyboard to select the Eraser tool. To delete any event using the 
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current 
selection and will only affect the event that is directly clicked on.

However, if you click on a selected element with the Eraser 
tool, all currently selected elements will be erased.

7.3.6.5 Common Editing Actions

Like most software applications, Capture supports basic cut, copy, 
and paste actions. Once you’ve selected an event, or a range 
of events, you can perform these actions as follows:

 • Cut: Press [Ctrl]/[Cmd]+X on the keyboard to cut 
the current selection or select Edit>Cut.

 • Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy 
the current selection or select Edit>Copy.

 • Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard 
to paste the selection or select Edit>Paste. The selection will be pasted to the 
current playback-cursor position, or to the beginning of the track from which 
the selection originated if the playback cursor is not currently set anywhere.
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7.3.6.6 Looping

To loop the playback of any range of your Capture Session, do one of the following:

 • Loop Selection. Select an event with the Arrow tool or select a range with 
the Range tool. Go to Session>Loop Selection or press P on your keyboard. 
This will create a loop the exact length of the selected audio event. The range 
will be indicated by a bar drawn in the timeline, with flags at both ends.

 • Custom Loop Range. To create a custom loop range, mouse over 
the gray line above the timeline ruler. Notice that your cursor 
changes to a Pencil tool, and you can draw your loop range.

Once your loop range is set, you can click on the Loop button in the transport, or 
press [L] or [/] on the keyboard, to engage Loop mode.

Please Note: Engaging Record in the transport will disable Loop mode and will begin 
recording at the current playback-cursor position. It is not possible to engage Loop while 
recording.

7.3.6.7 Bounce Selection

Once you have edited an audio file, you may wish to create a new audio file 
that includes all of your edits. To do this, use the Range tool to select the 
events you would like to merge as described in Section 7.3.6.2 and press 
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.
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7.3.7 Meter Bridge

Capture provides input and output metering when a track is being recorded 
or played back. These peak-style meters at the bottom of the Session page 
feature clip indicators for each input into Capture from the StudioLive mixer. 

Record Arm.

Below each meter, you will find another Record Arm button. This button provides the 
same functionality as the Record Arm button in the Track column. See Section 7.3.1 
for more information.

Link Button.

Between each meter you will find a Link button. When this button is active, Capture 
will record that track as a stereo-interleaved file. By default, the routable bus pair is 
link-enabled.

Big Meter Mode.

The Big Meter Mode button is located in the upper right 
corner of the Session page, above the editing tools.

When this button is engaged, the lower three-quarters of the Session page 
will display detailed metering for every track. While in this mode, the Marker 
Lane, transport, mode buttons, and editing tools will still be visible.

7.3.8 Markers and the Marker List

The Marker Lane.

The Marker Lane is located just below the Timeline Ruler. 
It displays any markers you have created.

In Capture, the Marker Lane is used to place markers at desired 
places in the timeline, after which navigation to the markers is easy. 
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Markers are also helpful when exporting your Session to individual 
mixes or for editing in another recording application.

Power User Tip: We highly recommend that markers be inserted during the recording of 
a live performance, as the markers will make the rest of the production process much 
easier.

The Marker List.

The Marker List button is located above the editing tools on the right side 
of the Session page. Clicking on the button will open the Marker List, which 
provides an overview of every marker in your Session and offers an easier 
way to quickly name markers and move them around your Session.

7.3.8.1 Inserting, Naming, Deleting, and Moving Markers

Marker Lane.

Adding/Deleting Markers. At the top of the Track column, you will see the Add/
Remove Marker buttons. To insert a new marker into the Marker Lane, with playback 
running or stopped, click on the Add Marker (+) button, or press [Insert] on the 
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3….).

Select a marker and click on the Remove Marker (-) button to remove the marker.

Naming Markers. To rename a marker, double-click on the marker in the Marker 
Lane, type in a new name, and then press [Enter] on the keyboard. 
 
 
 

Moving Markers. To move a marker, click on it in the 
Marker Lane and drag it to the desired location.
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Marker List.

At the bottom of the Marker List, you will find three buttons.

Adding Markers. Click on Add Marker to add a marker 
at the current playback-cursor position. 

When a Marker is added to the Marker List, the Name field 
automatically becomes editable. Enter a new name and hit Enter. 
This name can be edited later by double-clicking on it.

Moving Markers. Clicking on the Move Marker button will move the currently 
selected marker in the Marker List to the current playback position in the timeline.

Deleting Markers. To remove a marker, select it in the 
Marker List and click on the Delete Marker button.

7.3.8.2 Navigating Markers

It is possible to quickly jump the playback cursor between markers in 
the Marker Lane. Jumping to markers during playback allows quick 
comparisons between different sections of your Session.

To navigate to a previous marker, do one of the following:

 • Click on the Previous Marker button in the transport.

 • Press [B] on the keyboard, to jump to the previous marker.

To navigate to the next marker, do one of the following:

 • Click on the Next Marker button in the transport.

 • Press [N] on the keyboard, to jump to the next marker.

To jump to any marker in your Session, open the Marker List and click on the 
Location field. The playback cursor will jump to this location in the timeline.

7.4 Recording a Session in Capture

Setting Input Levels. Setting the proper input level is critical to making a good 
live mix and a good recording. The basic idea is to set the input gain on the 
StudioLive mixer as high as possible without overloading the input. Overloading 
the input will cause clipping (digital distortion), which is particularly unpleasant 
and will ruin the recording. This damage cannot be undone in software. There 
is a clip indicator for each input on the StudioLive mixer for this purpose.

If an input channel is not clipping on your StudioLive mixer, you can be 
sure that it will not clip in Capture. Refer to your StudioLive Hardware 
Owner’s Manual for the proper level-setting procedure.

You will monitor live audio input on the StudioLive mixer; there is no 
separate monitoring capability within Capture. Please refer to your StudioLive 
Hardware Owner’s Manual for information on creating monitor mixes.
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The Auxiliary Stereo Track in Capture is a stereo track intended to be used to record 
a stereo mix from your StudioLive. This mix can be recorded while recording the 
individual input channels so that a mix is available immediately after a live show, 
or you can use this track to route your final studio mixes through the StudioLive.

Arming Tracks. To record to an audio track, the track must be record-
enabled, or “armed.” Capture 2 provides two Record Enable buttons for 
each input: one on the track and on the meter bridge. Once an audio 
track is record enabled, you are ready to record audio to that track.

Hit Record. To activate recording, click on the Record button in the transport. The 
Record button will turn red, and the Play button will turn green. The playback cursor 
will start to scroll from left to right from its current position, and new audio events 
will be recorded to record-enabled tracks.

Recording will continue until you manually stop it by clicking on the Stop button in 
the Transport or by pressing [Spacebar] on the keyboard. 

When you press Record, the Session automatically locks. This prevents you from 
accidentally stopping recording Session. You must disable Session Lock before you 
can stop recording.

7.5 Virtual Soundcheck

We’ve all been there. The drummer is stuck in traffic. The guitarist is stuck at work. 
And you’re stuck at front-of-house (FOH) with a hyped up lead singer and bass player 
and no way to dial in a front-of-house mix, let alone set up the singer’s in-ear mix.

Don’t panic! With Capture’s Virtual Soundcheck mode, dialing a good rough 
mix without the band—or with half the band missing—is quick and simple.

1. To begin, create a new Session, preferably metatagged with the Artist, 
Performance, and Location information. 
 

2. From your empty Session, click on the Soundcheck Mode button 
in the upper right hand corner of the Session page.
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3. Capture will automatically search your computer for Sessions and will open 
a list from which you can choose a Session to use for Virtual Soundcheck.

4. Select the Session you would like to use and click “OK.”

5. The saved Capture Session will open.
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6. Press the USB Multimode button on your StudioLive 16.0.2 USB. 
 
 
 
 
 
 
 
 
 

7. Press every the multimode buttons on Channels 1 - 15/16. 
 
 
 
 
 
 
 
 
 

8. Press Play in Capture and dial in your mix.

9. When you have finished setting up your mix, click the Virtual 
Soundcheck Mode button again to exit. This will remove the audio from 
the session and disengage all the digital returns on your StudioLive, 
leaving the track labels in both Capture and on your mixer.

7.6 Remote Controlling Capture from UC Surface

When your StudioLive mixer is connected via USB to your computer 
and Universal Control, a Capture button will appear in the UC Surface 
Quick Access Panel once your StudioLive is synced to Capture.

Selecting this button will show Capture controls in the Fat Channel 
area of UC Surface. From within UC Surface, you can create a new 
Capture session, load a previously recording session, add markers, 
arm tracks for recording, and perform a virtual soundcheck.
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1. Add Marker

2. Delete Marker

3. Next/Prev Marker Navigation

4. Stop

5. Play

6. Record

7. Session Lock

8. Recording Length

9. Individual Track Arm

10. Curser Position

11. Disk Time

12. Close Session

13. Loop

14. Virtual Soundcheck

15. Arm All

7.7 Importing and Exporting Audio Files

7.7.1 Importing Audio Files into Capture

It is possible to import WAV and AIFF audio files into your Session.

1. To import an audio file, select Import Audio File from the Session menu, 
or [Ctrl]/[Cmd]+I on the keyboard, to open the Import File menu.

1 32 4 7 8 109 11 12 13 14 155 6
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2. Browse to the desired file and click on it to select it.

3. Click on Open to import the file into your Session.

4. An audio event for the imported file will be created and placed on the currently 
selected track in your Session, at the current playback-cursor position.

Power User Tip: When browsing for files in the Import File menu, it is possible to listen to 
the audio files as you are browsing in the Preview Player. Click the Play button in the 
Preview Player to play the currently selected audio file. Click the Stop button to stop 
playback. Click the Loop button to loop the playback of the currently selected audio file.

7.7.2 Export Audio Files

To export audio from your Session in Capture 2, navigate to Session/Export Tracks, 
or press [Ctrl]/[Cmd]+E on the keyboard to open the Export to Tracks menu.
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Location.

In the top section of the Export Tracks menu, select 
a location and name for the audio file.

Click on the Browse button to choose a file location.

Double-click on the filename, type in a new name, and then press Enter to 
choose a name for the file. Each file that is exported will begin with the filename 
you enter, followed by the name of the track from which it was exported 
and the first marker of the marker pair (if applicable). Examples: “French 
Quarter Fest 2012 – Kick” or “French Quarter Fest 2012 – Kick – Chorus.”

Format.

In the middle section of the Export Tracks menu, select the 
format of the mixdown audio file. Choose from WAV or AIFF, and 
then choose the desired resolution and sample rate.

If you wish to put your audio on a standard audio CD, the format should 
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.

Options.

The bottom section of the Export Tracks menu has several 
options that will affect how files are created:

 • Export Session will export the entire range of your Session to the 
furthest point in time that any audio event on a track extends.

 • Export Between Each Marker will export separate files for 
each range between the markers in the Marker Lane.

 • Export Between Selected Markers will export audio files between 
the ranges of any two selected markers in the Marker Lane.
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7.8 Mixing Your Capture Sessions

7.8.1 Creating a Mix in Capture

You can’t mix directly in Capture; instead, you mix with the StudioLive. The 
individual outputs of each audio track in Capture are hardwired to the digital 
returns for each corresponding input channel on the StudioLive mixer. With 
the digital returns engaged for each input channel on your StudioLive mixer, 
the output of your multitrack Capture Session is routed to your StudioLive 
mixer channels, where it can be mixed just like any other audio input.

The process of creating a mix with Capture and the StudioLive mixer is quite simple. 
Play back your recorded tracks through the StudioLive and record the main output of 
the StudioLive to the Auxiliary Stereo Track in Capture. The process works as follows:

1. Disable Record Arm for all audio-input tracks in Capture and engage the digital 
returns for all input channels on the StudioLive mixer and  
link channels 9/10 - 15/16.

2. In Capture, select the Main Mix Stereo Track.

3. Bring the playback-cursor position to the beginning of the Session by clicking 
the Return to Zero button in the transport.

4. Activate recording by clicking on the Record button in the transport; the 
playback cursor will begin to move from left to right, and audio will play through 
each input on the StudioLive mixer. The Main Mix Stereo Track in Capture will 
record a new audio event, which is the main mix from the StudioLive mixer.

The new audio event that has been recorded from the StudioLive mixer will be 
stored as a stereo WAV file at the sample rate to which the StudioLive mixer is set.

7.8.2 Exporting Your Final Mix to an Audio File

The most common physical medium on which recordings are published 
is the audio CD. In order to put your final mix on an audio CD, the mix file 
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final mix 
to the Main Mix Stereo track in Capture, it is recommended you export 
the audio from the Main Mix Stereo track to an audio file for this purpose. 
See Section 7.7.2 for details on Exporting Audio Tracks in Capture.

Once the correct audio file for your mix has been exported, you 
may use any CD-burning application (including PreSonus Studio 
One Professional) to put that mix on a recordable audio CD.

7.8.3 Mixing a Capture Session in Studio One

Many users want to use Capture strictly as a track-recording tool and will mix 
and sweeten the recorded tracks later in a DAW. PreSonus has included a copy 
of Studio One Artist with your StudioLive for this purpose. Capture sessions 
can be opened in both Studio One Artist and Studio One Pro. All markers, 
edits, track names, etc., will be preserved, and no further effort is required. If 
you’ve stored a StudioLive mix scene with your Capture session, Studio One 
will recall fader and pan values, as well as Fat Channel settings. Simply launch 
Studio One and open your Capture Session. See Section 8 for more details.
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7.8.4 Mixing a Capture Session in a Different Recording Application

For users who wish to mix their Capture Session in a DAW other than Studio 
One, there are several ways in which to import your Capture Session.

Save a Capture Session as OpenTL

Many audio-recording programs can open OpenTL (Open Track List) files. An OpenTL 
file provides a reference for all of the audio tracks and audio events, with their 
corresponding positions, in a Capture Session, so that another audio program can 
reconstruct your Session automatically. This makes it possible for you to open your 
Capture Session and work as you normally do in your favorite recording application.

To save an OpenTL version of your Session, select Save 
Session As in the File menu of Capture.

Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box.

Click on Save to save your Session as an OpenTL document and confirm the 
command by clicking Yes in the confirmation window. This file will be placed 
by default in your Session folder and will not overwrite the original Capture 
Session file. Note that the OpenTL format will not save your markers.

Import Capture Session Audio Files Directly

Some audio-editing applications (such as digital audio workstations, or DAWs) 
do not support the OpenTL format, which makes the options somewhat limited 
when importing Sessions created in other programs. In this case, you must 
manually import the audio events from your Capture Session into the audio-
editing application, using whatever means possible in that program. Refer to 
the documentation of your software for more information on this process.

Note that in some cases, you may have more than one audio event on a given track, 
as opposed to a single continuous audio event, or you may have audio events that 
do not have the same start position. In either case, it is highly recommended that 
you first export the audio for each track before attempting to import into an audio-
editing program, as described in the Export Audio Files portion of this section.

Be sure to select the Export Tracks option in the Export Audio 
File menu, as shown, so that the result of the process will be a 
single continuous audio file for each track in the Session.

Once you have single, continuous audio files for each track, directly importing 
the files into an audio editor is much easier. All that is required to reconstruct 
your Capture Session is to align each file at the same start time. For complete 
information on exporting tracks from Capture, please review Section 7.6.2.



67

7 Capture 
7.9 Capture Key Commands

StudioLive™ Software  
Library Reference Manual

7.9 Capture Key Commands

Action Key Command

File Menu

New Session Cntrl/Cmd+N

Open Session Cntrl/Cmd+O

Close Session Cntrl/Cmd+W

Save Session Cntrl/Cmd+S

Save Session As Cntrl/Cmd+Shift+S

Quit Cntrl/Cmd+Q

Edit Menu

Undo Cntrl/Cmd+Z

Redo Cntrl/Cmd+Y

Cut Cntrl/Cmd+X

Copy Cntrl/Cmd+C

Paste Cntrl/Cmd+V

Delete Del

Select All Cntrl/Cmd+A

Deselect All Cntrl/Cmd+D

Bounce Selection Cntrl/Cmd+B

Zoom In Cntrl/Cmd + or E

Zoom Out Cntrl/Cmd - or W

Zoom Full F

Session Menu

Import File Command+I

Export Tracks Command+E

Toggle Start/Stop Space Bar

Record NumPad *

Stop 0

Return to Zero ,

Go to End E

Loop Active /

Loop Selection P

Locate Selection L

Insert Marker Ins, I

Insert Named Marker Shift+Ins, Shift+I

Locate Next Marker N

Locate Previous Marker B

Enable Sound Check F4

Tools

Select Arrow Tool 1

Select Range Tool 2

Select Split Tool 3

Select Eraser Tool 4

Views

Options Cntrl/Cmd+[+]

Big Meters F2

Marker List F3

Enable Soundcheck F4

Action Key Command

Transport

Toggle Start/Stop Space Bar

Start Enter

Record NumPad *

Stop NumPad 0

Return to Zero NumPad

Record Lock Cntrl/Cmd+L

Navigation

Focus Next Tab

Focus Previous Shift+Tab

Left Left Arrow

Extend Selection Left Shift+Left Arrow

Extend Selection Left Add Cntrl/Cmd+Shift+Left Arrow

Skip Left Cntrl/Cmd+Left Arrow

Right Right Arrow

Extend Selection Right Shift+Right Arrow

Extend Selection Right Add Cntrl/Cmd+Shift+Right Arrow

Skip Right Cntrl/Cmd+Right Arrow

Up Up Arrow

Extend Selection Up Shift+Up Arrow

Extend Selection Up Add Cntrl/Cmd+Shift+Up Arrow

Skip Up Cntrl/Cmd+Up Arrow

Down Down Arrow

Extend Selection Down Shift+Down Arrow

Extend Selection Down Add Cntrl/Cmd+Shift+Down Arrow

Skip Down Cntrl/Cmd+Down Arrow

Page Up Page Up

Extend Selection Page Up Shift+Page Up

Extend Selection Page Up 
Add

Cntrl/Cmd+Shift+Page Up

Skip Page Up Cntrl/Cmd+Page Up

Page Down Page Down

Extend Selection Page 
Down

Shift+Page Down

Extend Selection Page 
Down Add

Cntrl/Cmd+Shift+Page Down

Skip Page Down Cntrl/Cmd+Page Down

Start Home

Extend Selection Start Shift+Home

Extend Selection Start Add Cntrl/Cmd+Shift+Home

Skip Start Cntrl/Cmd+Home

End End

Extend Selection End Shift+End

Extend Selection End Add Cntrl/Cmd+Shift+End

Skip End Cntrl/Cmd+End
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8 Studio One Artist Quick Start

All PreSonus professional recording products come with Studio One Artist 
recording and production software. Whether you are about to record 
your first album or your fiftieth, Studio One Artist provides you with all 
of the tools necessary to capture and mix a great performance. 

Power User Tip: As a valued PreSonus customer, you are eligible for a discount upgrade 
to Studio One Professional. For more details on the Studio One upgrade program for 
PreSonus customers, please visit http://www.presonus.com/products/Studio-One/
get-studio-one.

8.1 Installation and Authorization

Once you have installed the drivers for your audio interface and connected it 
to your computer, you can use the included PreSonus Studio One Artist music-
production software to begin recording, mixing, and producing your music. 
To install Studio One Artist, log into your My PreSonus account and register 
your interface. Your product key for Studio One Artist will automatically be 
registered to your My PreSonus account with your hardware registration.

Downloading and running the Studio One installer.

To install Studio One Artist, download the Studio One Artist installer from 
your My PreSonus account to the computer on which you will use it.

 • Windows users: Launch the Studio One Artist installer 
and follow the onscreen instructions.
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 • Mac users: Drag the Studio One Artist application into 
the Applications folder on your Mac hard drive.

Authorizing Studio One

When Studio One is launched for the first time on your computer, it will 
communicate with your My PreSonus account and verify your registration. To 
ensure a seamless authorization process, make sure to download your installer 
to the computer on which you will be using it and be sure that your computer is 
connected to the Internet when you launch the application for the first time.

Installing bundled content for Studio One Artist.

Studio One Artist comes bundled with an array of demo and tutorial 
materials, instruments, loops, and samples. The Studio One Artist 
bundle includes all that you need to begin producing music.

The first time you launch Studio One Artist, you will be prompted 
to install its companion content. Select the content you wish to 
add and click “Install.” The content will automatically begin to 
download and install from your My PreSonus user account. 

Power User Tip: You may be prompted to enter your My PreSonus user account 
information. Clicking “Remember Credentials” will allow you to have immediate access to 
any content you purchase from the PreSonus Marketplace. 

8.2 Setting Up Studio One

Studio One Artist was designed to work with PreSonus interfaces and provides 
unique interoperability and simplified setup. When Studio One Artist is 
launched, by default you will be taken to the Start page. On this page, you will 
find document-management and device-configuration controls, as well as a 
customizable artist profile, a news feed, and links to demos and tutorials from 
PreSonus. If you have an Internet connection on your computer, these links will 
be updated as new tutorials become available on the PreSonus Web site.

Complete information on all aspects of Studio One Artist is available in 
the Reference Manual PDF located within Studio One. The information 
in this tutorial covers only the basic aspects of Studio One Artist and is 
intended to get you set up and recording as quickly as possible.
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8.2.1 Configuring Audio Devices

1. In the middle of the Start page, you will see the Setup area. Studio One 
Artist automatically scans your system for all available drivers and selects 
a driver. By default, it will choose a PreSonus driver if one is available. 

2. If you do not see your device listed on the Start page when 
you launch Studio One, click on the Configure Audio Devices 
link in the Setup area to open the Options window. 

In the Options window, click on the Audio Setup tab and 
select your device driver from the pull-down.
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8.2.2 Configuring MIDI Devices

From the External Devices window in Studio One Artist, you can configure 
your MIDI keyboard controller, sound modules, and control surfaces. This 
section will guide you through setting up your MIDI keyboard controller 
and sound modules. Please consult the Reference Manual located within 
Studio One for complete setup instructions for other MIDI devices.

If you are using a third-party MIDI interface or USB MIDI-controller 
keyboard, you must install any required drivers for these devices before 
beginning this section. Please consult the documentation that came 
with your MIDI hardware for complete installation instructions.

If you do not have any MIDI devices, please skip to Section 8.3.

Setting up an external MIDI keyboard controller from the Start page.

A MIDI keyboard controller is a hardware device that is generally used for playing 
and controlling other MIDI devices, virtual instruments, and software parameters. 
In Studio One Artist, these devices are referred to as Keyboards, and they must be 
configured before they are available for use. In some cases, your MIDI keyboard 
controller is also used as a tone generator. Studio One Artist views the controller 
and tone-generation functions as two different devices; a MIDI keyboard controller 
and a sound module. The MIDI controls (keyboard, knobs, faders, etc.) will be 
set up as a Keyboard. The sound modules will be set up as an Instrument.

You can set up your external MIDI devices from the Setup area 
in the Start page. Before setting up a new Song for recording, 
take a moment to configure external devices.

Make sure you have connected the MIDI Out of your external MIDI controller to 
a MIDI In on your PreSonus audio interface (if available) or other MIDI interface. If 
you are using a USB MIDI controller, connect it to your computer and power it on.

1. Click on the Configure External Devices link in the Setup area on 
the Start page to launch the External Devices window.
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2. Click the Add button. This will launch the Add Device window.

3. From the menu on the left, select your MIDI controller from the list of 
manufacturers and models. If you do not see your MIDI controller listed, 
select New Keyboard. At this point, you can customize the name of 
your keyboard by entering the manufacturer and device names.

4. You must specify which MIDI channels will be used to communicate with 
this keyboard. For most purposes, you should select all MIDI channels. 
If you are unsure of which MIDI channels to choose, select all 16.

5. Studio One allows you to filter out specific control functions. If you would 
like Studio One to ignore Aftertouch, Pitch Bend, Program Change, or 
All CC messages, enable filtering for any or all of these messages.

6. In the Receive From drop-down menu, select the MIDI interface 
input from which Studio One Artist will receive MIDI data (that 
is, the MIDI port to which your keyboard is connected).

Power User Tip: In the Send To drop-down menu, select the MIDI interface output 
from which your Studio One Artist will send MIDI data to your keyboard. If your 
keyboard controller doesn’t need to receive MIDI data from Studio One, you can leave 
this unselected.
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7. If this is the only keyboard that you will use to control your external 
synthesizers and virtual instruments, you should check the box 
next to Default Instrument Input. This will automatically assign your 
keyboard to control all MIDI devices in Studio One Artist.

8. Click OK.

If you have a sound module that you’d like to connect, leave the External 
Devices window open and proceed to the next part of this section. 
If not, you can close the window and skip to the next section.

Setting up an external MIDI sound module from the Start page.

MIDI instrument controllers (keyboards, MIDI guitars, etc.) send musical information 
in the form of MIDI data to tone modules and virtual instruments, which respond 
by generating sound, as instructed. Tone modules can be standalone sound devices 
or can be integrated into a MIDI instrument, such as a keyboard synthesizer. Studio 
One Artist refers to all tone generators as Instruments. Once you have set up your 
MIDI keyboard controller, take a moment to configure your sound module.

Make sure you have connected the MIDI In of your external 
sound module to the MIDI Out of your MIDI interface.

1. In the External Devices window, click the Add button.



74

8 Studio One Artist Quick Start 
8.3 Creating a New Song

StudioLive™ Software  
Library Reference Manual

2. Select your device in the menu on the left. If your device is not listed, 
select New Instrument. At this point you can customize the name of 
your keyboard by entering the manufacturer and device names.

3. Specify which MIDI channels will be used to communicate with this sound 
module. For most purposes, you should select all MIDI channels. If you are 
unsure of which MIDI channels to select, we suggest you select all 16.

4. In the Send To menu, select the MIDI interface output from which Studio One 
Artist will send MIDI data to your sound module. Click OK and close the External 
Devices window. You are now ready to start recording in Studio One Artist. 

The rest of this Quick Start Guide will go over how to set 
up a Song and will discuss some general workflow tips for 
navigating through the Studio One Artist environment.

8.3 Creating a New Song

Now that you’ve configured your audio and MIDI devices, let’s create 
a new Song. We’ll start by setting up your default audio I/O.

1. From the Start page, select Create a New Song.
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2. In the New Song window, name your Song and choose the directory in which 
you’d like it saved. From the Interfaces tab, you can select custom templates 
for your StudioLive mixer that will set all configuration and I/O settings for 
you. The rest of section will describe creating a Song from an empty session.

3. Select Empty Song from the Templates list. At this point, you should give 
your Song a name and select your preferred sample rate and bit depth for 
recording and playback. You can also set the length of your Song and the 
type of time format you would like the timeline to follow (notation bars, 
seconds, samples, or frames). Click the OK button when you are finished.

Power User Tip: If you plan to import loops into your Song, make sure that the Stretch 
Audio Files to Song Tempo option is selected. This will automatically import loops at the 
correct BPM.

8.3.1 Configuring Your I/O

1. Click on Song | Song Setup to set your sample rate and 
resolution and configure your audio I/O.

2. Click on the Audio I/O Setup tab.
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3. From the Inputs tab, you can enable any or all of the inputs on your 
StudioLive mixer that you’d like to have available. We recommend that 
you create a mono input for each of the inputs on your interface. If 
you plan on recording in stereo, you should also create a few stereo 
inputs. You can give each input a custom name by simply clicking 
on the default name. Press the TAB key to edit the next name.

4. Click on the Outputs tabs to enable any or all of the outputs on your StudioLive 
Mixer. In the lower right corner, you will see the Audition select menu. This 
allows you to choose the output from which you will audition audio files prior 
to importing them into Studio One Artist. In general, you will want this to be the 
Outputs 1 and 2. This will route the audio from Studio One to both the Digital 
Returns on Channels 1 and 2 and the Main Digital Return in the Monitor Bus on 
your mixer. You can give each output a custom name by simply clicking on the 
default name. Press the TAB key to edit the next name. Click Apply when done.

Power User Tip: If you would like this I/O configuration to be the same every time you 
open Studio One, click the Make Default button.
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8.3.2 Creating Audio and MIDI Tracks

1. In the upper left corner of the Arrange window, you will notice 
several buttons. The button furthest to the right is the Add Tracks 
button. Click on this button to open the Add Tracks window.

2. In the Add Tracks window, you can customize the track name and 
color, add a preset rack of effects, and set the physical source for 
the input and output of your audio tracks. Most important, you 
can select the number and type of tracks you’d like to create.

 • Audio. Use this track type to record and playback audio files.

 • Instrument. Use this track to record and playback MIDI data to 
control external MIDI devices or Virtual Instrument plug-ins.

 • Automation. This track type lets you create automated 
parameter controls for your session.

 • Folder. This track helps you to manage your session as 
well as to quickly edit multiple tracks at once.

Power User Tip: If you would like to add an audio track for each of the available inputs, 
simply go to Track | Add Tracks for All Inputs.

Mute

Custom
Track
Color

ST/Mono

Audio Input
Source Select

Solo

Rec
Arm

Monitor

Track
Name

Meter

Note: MIDI tracks are nearly identical to Audio tracks. The Input Source list for MIDI tracks 
lists available external MIDI devices as well as any virtual instruments that have been 
added to the Song.
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8.3.3 Recording an Audio Track

1. To begin recording, create an audio track from the Add Tracks 
window, set its input to Input 1 on your StudioLive mixer.

2. Connect a microphone to Channel 1 on your StudioLive 16.0.2 USB. 
 
 
 
 
 
 
 
 
 

3. Select Record Enable on the track. Turn up the Input 1 level on your 
mixer while speaking/singing into the microphone. You should see the 
input meter in Studio One Artist react to the input. Adjust the gain so 
the input level is near its maximum without clipping (distorting).

4. Turn up the Input 1 level on your mixer while speaking/singing into the 
microphone.  
 
 
 
 
 
 
 
 

5. You should see the input meter in Studio One Artist react to the input. Adjust 
the gain so the input level is near its maximum without clipping (distorting).

You are now ready to start recording. For complete instructions, please consult the 
Studio One Reference manual located in Help | Studio One Reference Manual.
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8.3.4  Adding Virtual Instruments and Effects

You can add plug-ins and instruments to your Song by dragging-and-dropping 
them from the browser. You can also drag an effect or group of effects from one 
channel to another, drag in customized effects chains, and instantly load your 
favorite virtual-instrument preset without ever scrolling through a menu.

Opening the browser.

In the lower right corner of the Arrange window are three buttons:

 • The Edit button opens and closes the audio and MIDI editors.

 • The Mix button opens and closes the Mixer window.

 • The Browse button opens the browser, which displays all of the 
available virtual instruments, plug-in effects, audio files, and MIDI files, 
as well as the pool of audio files loaded into the current session.

Drag-and-drop virtual instruments.

To add a virtual instrument to you session, open the browser and click on 
the Instrument button. Select the instrument or one of its patches from the 
instrument browser and drag it into the Arrange view. Studio One Artist will 
automatically create a new track and load the instrument as the input.
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Drag-and-drop effects.

To add a plug-in effect to a track, click the Effects button in the browser and 
select the plug-in or one of its presets in the effects browser. Drag-and-drop 
the selection over the track to which you would like to add the effect.

8.3.5 Drag-and-Drop Audio and MIDI Files

Audio and MIDI files can be quickly located, auditioned, and imported into 
your Song by dragging them from the file browser into the Arrange view. 
If you drag the file to an empty space, a new track will be created with that 
file placed at the position to which you dragged it. If you drag the file to 
an existing track, the file will be placed as a new part on the track.

8.4 Remote Controlling your StudioLive 16.0.2 USB from Studio One

The StudioLive 16.0.2’s MIDI Control mode enables you to MIDI-control 
several features on your mixer from a DAW or other MIDI source. When 
controlling the mixer from a DAW, you don’t need to worry about 
connecting an external MIDI interface because the StudioLive 16.0.2 
USB can receive MIDI control messages over its USB connection.

These setup instructions will enable you to quickly configure 
Studio One Artist to control your StudioLive, while giving you the 
information necessary for you to create a custom configuration.

You must first set up your StudioLive for MIDI control, so 
navigate to pages 3 and 4 of your StudioLive system menu 
and set each page up as shown in these images:
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8.4.1  Configuring StudioLive 16.0.2 as a MIDI Device

To configure your StudioLive 16.0.2 for control by Studio One Artist, 
you must first add the StudioLive as an external device.

1. From the Studio One Artist Start page, click on the External Devices link.

2. Click on the Add button.

3. Select New Instrument.

4. In the Device Name field, enter “StudioLive.”

5. From the Send To menu, select “StudioLive 16.0.2 USB.”

6. Click the All button to enable all MIDI channels.

7. Click OK.

8. In the StudioLive System menu, navigate to Page 4: MIDI 
Presets and set MIDI Control Mode to “ON.”



82

8 Studio One Artist Quick Start 
8.4 Remote Controlling your StudioLive 16.0.2 USB from Studio One

StudioLive™ Software  
Library Reference Manual

8.4.2  Recalling Scenes and Presets

In our example, you have to set different MIDI channels to recall Scenes, 
FXA Presets, and FXB Presets. These are the MIDI channels on which 
Studio One will send Program Change messages for each function.

1. In Studio One, create a new Song and then create an Instrument track.

2. In the Output menu, select “StudioLive CH 1.”

3. Open the Inspector and let’s change a StudioLive Scene. 

4. Check the box next to Program.

Power User Tip: If you don’t see the Program field, drag down the Resize bar at the 
top of the Inspector to show the hidden fields. 

5. Double-click on the Prog field and type in the 
number of the Scene you wish to recall. 

You can recall FX presets using the same steps. Don’t forget to change 
the MIDI channel to match what you’ve set on your StudioLive!
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8.4.3 Controlling FXA, FXB, and Main Output Levels 

1. In Studio One, select the Paint tool.

2. Using the Paint tool, draw a MIDI region several bars long.

3. Set the MIDI channel for the Instrument track to 4.

4. In the Track menu, select “Add Automation Track.”

5. From the Automation Track Inspector, click on the 
Parameter menu and select “Add/Remove.

6. From the Automation window, select “External Devices > CH4.”
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7. Scroll through the MIDI Control Change list until you find Controls 40-42.

8. Select these controls and click Add.

9. Click Close.

10. Select Control 42 from the parameter pull-down menu on the automation track.

11. Using your Paint tool, draw an automation curve.

12. Press Play to hear Studio One control the main output level of your StudioLive.

You can use the same steps to create volume-curve automation for 
FXA and FXB output levels on your StudioLive mixer. Just be sure 
to select the right Control Change number from the parameter 
pull-down menu on the automation track in Studio One!

8.4.4  Assigning/Unassigning FXA and FXB to the Main Bus 

1. In Studio One, select the Paint tool.

2. Using the Paint tool, draw a MIDI region several bars long. 
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3. Set the MIDI channel for the Instrument track to 4.

4. In the Track menu, select “Add Automation Track.” 

5. From the Automation Track Inspector, click on the 
Parameter menu and select “Add/Remove.

6. From the Automation window, select “External Devices > CH4.”

7. Scroll through the MIDI Control Change list until you find Sustain Pedal 
On/ Off (CC 64) and Sustenuto Pedal On/Off (CC 66). Unlike volume control, 
the mute controls require On/Off messages; therefore, we recommend 
using these two Control Change numbers when controlling the StudioLive 
16.0.2 USB with Studio One Artist. Select each control and click Add. 
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8. Click Close. 

9. Select Sustain Pedal On/Off from the Parameter 
pulldown menu on the automation track.

10. Using your Pencil tool, draw an “ON” message that lasts for several bars. Note 
that the FXA/FXB assignment to the main bus is a simple toggle, so when 
it receives its CC message, the button will be put into the opposite of its 
current state. If you want the “On” state in Studio One to turn the button on, 
the button will need to be in the “Off” state when it receives the message. 

11. Press Play to watch and hear Studio One assign and unassign FXA to 
the Main bus. These same steps can be used to control FXB assign/
unassign to the Main bus. Just be sure to select the correct Control 
Change message from the Automation track’s parameter menu.
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 Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for…

Jambalaya
Ingredients:
 • 5 lbs link andouille sausage 

 • 3 lbs boneless chicken

 • 2 lbs ground beef

 • 3 lbs onions (yellow or purple)

 • 2 stalks of celery

 • 1 lb bell peppers (green or red)

 • 1 batch green onions

 • 3 lbs rice

 • Tony Chachere’s Cajun Seasoning

 • 1 bottle chicken stock concentrate (or 3 cubes chicken bullion)

 • 1 can Rotel tomatoes with chilies, diced (regular hot)

 • Tabasco sauce

Cooking Instructions:
1. In a 16 qt. pot or larger, slice link sausage and pan-fry until brown. 

2. Add ground beef and brown.

3. Do not remove from pot Add diced onions, celery, and bell peppers,  
1 can Rotel Original diced tomatoes with chilies, 3 oz concentrate chicken stock,  
½ teaspoon of Cajun seasoning, 1 teaspoon of Tabasco hot sauce  
(or more…maybe lots more).

4. Cook until onions are translucent.

5. Add chicken and cook until it turns white.

6. Add diced green onions, 1 tsp. salt, ½ gallon water and bring to a boil.

7. Add rice and bring to a boil. Cook on high for 8  minutes, covered, stirring every 2 minutes

8. Cook covered on low for 10 minutes, stirring only once.

9. Turn off and let sit for 30 minutes.

10. Serve and enjoy!

Serves 20
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